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HOW TO CONTACT ANDOVER ADVANCED TECHNOLOGIES

We can be reached by the following methods for questions, comments, and technical support:

Mail:
Andover Advanced Technologies, Inc.
532 Great Road
Acton, MA 01720, USA

Phone: (9AM-6PM EST, Monday-Friday)
(508) 635-5300
(508) 635-5326 FAX

Internet & Electronically:
Support@andatech.com
http://www.andatech.com
CompuServe: Go ANDOVER



WELCOME AND GENERAL OVERVIEW

The magic of Hollywood never ceases. Spectacular aquatic worlds have been brought to life, long lost starlets 
have been resurrected, and incredible transmogrifications bring everyday objects to life. Big budget studios 
spend millions to make the impossible happen. From the fluid transformations of "morphing", to Hollywood's 
long time friend, "blue screening", to advanced texture mapping and compositing filters, a complete palette of 
amazement makers can be found in PhotoMorph 2 -- millions of special effects are waiting to be discovered!

In this manual
This manual contains information on getting started with PhotoMorph 2. Following a brief overview, we'll go 
through most of PhotoMorph 2's functions. Then you'll be ready to create stunning special effects on your PC.

General Overview
PhotoMorph 2 creates special effects from various types of source material. Images stored in many popular 
formats, as well as video clips stored in the AVI file format can be used in PhotoMorph 2. If PhotoMorph 2 does
not directly support the format you need, its screen capture utility can be used to import any image you want. If 
you can put it on your screen, you can use it with PhotoMorph 2!

Once the source materials have been loaded, they can be edited. PhotoMorph 2 has many image editing features
built into it, including: cropping, scaling, framing, and rotating. Color correction tools including Contrast, 
Brightness, and Saturation as well as basic filter effects are provided. Video files can be edited by setting in and 
out points and sampling options.

After basic editing, the special effects are created. The Project Editor is the command center of PhotoMorph 2. 
There are areas for the start and end source materials. The six filters, Colorize, Distort, Morph, Overlay, 
Transition and Warp, are chosen from a drop down list. Up to three filters can be applied simultaneously. The 
filter's Editor, Options, Preview window and AVI Player are only a mouse click away.

The PhotoMorph 2 Project Editor

Sequential effects are chained together using the Storyboard. Used in combination with the video editing 
options, the Storyboard can be used to perform basic non-linear video editing.



With the editing complete, the finished project can be saved and rendered. PhotoMorph 2 saves its projects as 
PMP files which can be reloaded and edited at a later time. Video files, (AVI) need to be rendered. AVI files can 
be played back on any PC using Microsoft's Video for Windows. Although you can reuse AVI files within a new
PhotoMorph 2 Project, it is impossible to recreate a PMP file from an AVI file. There are a number of sample 
PMP files included in this package.

Once the finished video has been created, the resultant AVI file can be viewed with the AVI Player. This AVI 
can also be imported into most presentation packages, be edited with other video editing software, or have 
sound added to it. With special hardware, AVI files can be recorded on video tape.



GETTING STARTED WITH PHOTOMORPH 2

Tutorial 1 - Loading and Rendering an Existing PhotoMorph 2 Project
The purpose of this tutorial is to introduce you to PhotoMorph 2 Project and video clip files. PhotoMorph 2 
Project files, which take up relatively little disk space, can be loaded, edited, and saved again. Generally, video 
clips take up large amounts of disk space, but can be played back using the AVI Player.

To load a pre-existing PhotoMorph 2 Project and create a video:
1. Open PhotoMorph 2. The Project Editor will be on your screen.

2. Notice the row of buttons on the top of the Project Editor. The first button, the Open Project button, allows 
you to open PhotoMorph Project (PMP) files. It is important to note that PMP files are the only files that 
can be loaded with this button. Image and video files are loaded elsewhere. Click on the Open Project 
button in the Project Editor Toolbar.

The Open Project Button

3. Select a PhotoMorph 2 project from the Open dialog box that appears. PhotoMorph 2 Projects have the 
extension PMP. If no PhotoMorph 2 Projects are showing, use the Open dialog box to change to the 
directory that PhotoMorph 2 has been installed in.

Please note that during the opening of a project, all source materials for that project (images and video 
clips) are loaded into the main work area of PhotoMorph 2. Also notice that each window in the work area 
has a title bar. The current window, whether it is an image, video clip, or the Project Editor, has a different 
color title bar (usually dark blue). The menu items at the top of the screen change depending on the window
that is current. For example, because the Filter menu can only be applied to image windows, it is not 
available when the Project Editor is current.

By default, the Project Editor "floats" above all source materials. This setting can be changed in the 
Preferences section (Second from the right on the Project Editor tool bar) of the Project Editor.

4. Click on the Create Animation button in the Project Editor, which by default creates a video clip with the 
extension AVI. Give the video a filename, press OK, and wait as the video is generated, based on the 
information contained in the PMP file.

5. Once the video file (AVI) has been created, it can be loaded and played in the AVI Player. The fifth button 
over from the left on the project editor resembles a movie projector. Click on this button to open the AVI 
Player.

The AVI Player Button

6. Because no AVI file has been loaded previously, an open dialog box will appear. Open the AVI file you 
created in the previous steps by clicking on its filename and pressing OK. 

7. Once the AVI video clip has been loaded, click on the Play button to view the finished video.



Tutorial 2 - Creating a Morph Movie
Morphing is the easiest way to create compelling digital video from still images; let's go through the process. 
Suppose you are making a presentation to an automobile manufacturer. The concept is to show the power of a 
sports car, combined with the space of a minivan. Morphing is a great way to send this message, so we'll morph 
the sports car into a minivan.

1. Open PhotoMorph 2. If you are already in PhotoMorph 2, select Project, New from the File menu in the 
upper left hand corner of your PhotoMorph 2 Window.

2. When morphing, start and an end materials are required. Notice in the Project Editor the two blank 
Windows, labeled Start and End. Under each Window, you will see a drop down list. Once an image is 
chosen for the start and end images, <<No Image>> will be replaced with the file name of the image that 
you are working with. To the right of both drop down lists, you will find a small file folder button. Click on 
the one under Start Image.

The Open Image Button

3. Now you will be opening a start image. In the Open Image dialog box, you will see where it indicates "List 
Files of Type". Select JPG - JPEG Compressed. This will allow you to load images stored with the 
extension .JPG into PhotoMorph 2. You may want to take a moment to note the other formats that can be 
loaded.

4. Locate the file SMLCAR2.JPG (an image of a sports car) in your PhotoMorph 2 directory. Click on it and 
press OK to load it as the start image in the Project Editor. 

5. Next, we need to load an end image. Click on the Open End Image button underneath the End Image 
window. Choose BIGCAR2.JPG and press OK.

6. The Project Editor now appears with a sports car in the Start window and a minivan in the End window. 
Note that Morph has been chosen as the default in the Filter Type List. PhotoMorph 2 contains six filters: 
Colorize, Distort, Morph, Overlay, Transition, and Warp. For now, we'll stick to Morphing.

7. Click on the Edit button. This will open the Morph/Warp Editor. Again, the start image is located on the left
and the end image is located on the right.

8. Notice the tool bar located to the left of both images. Each Button has a specific purpose:
a. The top button places points onto the images. What points do will be explained below.
b. The second button moves points. The currently selected point can be moved by clicking and dragging, 

pointing and clicking with the right mouse button, or with the cursor keys.
c. The third button erases points.
d. The fourth button allows you to zoom in and out upon the image. When this button is selected, click on

the image to zoom in, shift-click (hold down the shift key while clicking with the left mouse button) on
the image to zoom out.

e. The bottom button is for customizing the color scheme of the points.

9. Note that this Window can be re-sized and "maximized" - just like most windows. By expanding the 
window, more of each image is shown.

10. Using your mouse, point to a spot on the bottom of the rear bumper of the sports car in the start image. 
Click with the left mouse button. A point will appear on the image and a corresponding point appears on the
end image.



11. Now move the cursor over to the end image and position it over the active (red) point you just placed. Click
and drag the point to the bottom of the rear bumper of the minivan.

12. Place and move points in a similar manner in the following locations:
a. Center of rear tire
b. Center of front tire
c. Bottom of front bumper
d. Top of front bumper
e. Front of hood
f. Bottom of windshield
g. Top of windshield
h. Top of back of car
i. Top of rear bumper

Your finished morph point placements should look like this:

The Completed Morph Points

13. Now you've placed all your 'Married Point Pairs'. We call them Married because they are linked together. 
Each point on the start image has a representation on the end image. By placing Married Points, you link 
the similar features of the two objects together. Once you are satisfied with your point selections, press OK.

14. Preview the video by using the Preview button on the Project Editor, sixth from the left, that resembles a 
Magnifying Glass. Click on it now.

The    Preview Button

15. The Preview window appears. Use the percentage slider to look through your video's frames. Notice the 
other buttons in the Preview window. The Up Arrow updates the image, which is useful when editing a 
morph. The second button saves the image shown to a file; this is handy for using still PhotoMorph 2 
images with other software packages. The third button saves the image to a new PhotoMorph 2 Window, 
which allows you to reuse or print the image in PhotoMorph 2.



16. If you want to save your PhotoMorph 2 Project, which consists of the points and images you have selected, 
click on the Save Project button in the Project Editor. It is the second button from the left. Save the file with
the extension PMP. Note that you are not creating the finished video in this step, you are merely saving the 
points you have placed, so you can edit the points (or further refine this project) sometime later.

17. When you are satisfied with your preview and point placement, click on the Create Animation button as we 
did in the previous tutorial. Give the video a filename with the extension AVI.

18. Once the video is created, open the AVI Player. (Movie Projector, fifth from the left), load and play your 
video!

Although there are a number of steps involved, morphing is very easy. In fact, all of PhotoMorph 2's features 
are powerful, yet intuitive and easy to use. As you dig into PhotoMorph 2, you'll see just how easy it is to create 
incredible digital video with your PC. Welcome to the world of digital video special effects!



THE NEXT STEP... MORE SPECIAL EFFECTS
We've started with Morphing, now we'll explore the other effects in PhotoMorph 2.

The Colorize Filters
The Colorize features in PhotoMorph 2 allow you to apply 19 special filters directly to images and video clips. 
You can use the Old Movie filter to make any video clip look like an old black and white movie. You can use 
the Contrast filter to add or decrease the contrast of a video clip as you would with a TV set.

The Colorize Editor

Tutorial 3 - Using the Colorize Editor
Let's apply the old time movie filter to a video clip. We also want the filter to fade in linearly, as the video 
progresses. This is very easy to do with the Colorize filter.

1. Start PhotoMorph 2. If you already have PhotoMorph 2 running, choose File / New... Project. This will 
clear PhotoMorph 2 of any existing Projects.

2. Locate the Open Start Image button in the Project Editor. This button, a small file folder, is located under 
the start image window. Press it to access the Open Image dialog box.

3. In the Open Image dialog box, you will see where it indicates "List Files of Type". Select AVI - Video for 
Windows. This will allow you to load video clips into PhotoMorph 2. In PhotoMorph 2, video clips are 
treated exactly the same as images, except that video clips change over time.

4. Locate the file CHRIS26.AVI in your PhotoMorph 2 directory. Click on it and press OK to load it as your 
start image in the Project Editor. CHRIS26 is a video clip of Chris spinning on a stool in front of a Blue 
Screen. The Colorize Filter does not require an End image. 

5. In the Project Editor, choose Colorize from the Filter Type drop-down list. Press Edit to enter the Colorize 
Editor.

6. On the left of the editor there are 19 different Colorize filters. Since we want to apply the Old Movie filter, 
choose it from the list.

7. Notice that the preview built into the Colorize Editor will indicate how the filter will transpire. Adjust the 
slider from left to right, to see how the filter will change over time. In this case, the Old Movie filter will 
fade in as Chris spins. Press OK.



8. Now lets make this into a movie. Press Create Animation to save this movie as an AVI file. Give it the 
filename OLDMOVIE.AVI and press OK. Once the video is finished rendering, access the AVI Player (the
Movie Projector button in the Project Editor or via the View Menu), load OLDMOVIE.AVI and press 
Play. Chris will spin while the Old Movie filter fades in.

Holding an Filter At a Constant Rate
Suppose we wanted to have the Old Movie filter be applied evenly throughout the whole clip, instead of faded 
in. We can do this using the Clip Options. 

(Continued from the above tutorial)
9. In the Project Editor, press Options. In the lower right hand corner of this screen, you will notice where it 

says Filter Percentage. This control is used to indicate how the filter changes over time. When set to 
variable, the filter changes over a period of time. If set to constant, the filter will remain at a constant level. 
Since we want to have the Old Movie filter applied evenly, set this control to Constant, 100%. This will 
apply Old Movie at full strength (100%) through the entire clip. Press OK.

10. Repeat Step 8 to render the new version of this movie. 

You will notice that some of the Colorize filters, such as Contrast, Noise, and Trace Edges have slider controls 
in them, allowing precise adjustment of the filter.

The Colorize filters can be used in combination with other Filter Types to create truly beautiful results. All 
Colorize filters work with alpha channels, allowing you to selectively colorize only certain parts of the source 
material. An example of this can be found in Tutorial 10 - Using the Image/Mask Menu to Construct Basic 
Alpha Channels. It is also useful to know that you can use several Colorize filters in a single clip. You can 
boost the contrast of a clip with the Contrast filter, you can then use the Blur filter, and finally you can apply the
Old Movie filter. You can do all this in a single clip using the multiple filters. Check out Tutorial 8 - A Simple 
Example of Multiple Filter Layers for more details.

The Transition Filters
The PhotoMorph 2 Transition Editor provides more than 256,000 combinations of video transitions. Besides 
providing a list of popular presets, its WYSIWYG interface allows you to create stunning scene changes with 
ease. 

The Transition Editor



To access the Transition Editor:
1. Load a start image or video clip into the Project Editor.
2. Load an end image or video clip of the same dimensions as the start material. When transitioning to a solid 

color (such as a fade to black), an end image / video is not required.
3. Select Transition from the list of Filter Types in the Project Editor.
4. Press Edit.

Direction Arrows
The heart of the Transition Editor lies in the Direction Arrow buttons. The Direction Arrows specify the 
direction that the image or video clip will move as time passes. The left set of arrows control the transition 
direction for the Start image, the right set of arrows control the direction of the End image. For example, if only 
the 'up' arrow is specified for the Start image, the Start image will move up, revealing the End image. If both the
up and down arrow are specified, it will break into two pieces; the top half will transition up and the bottom half
will transition down. This is the general method for all of the Direction Arrows. If you specify all eight direction
arrows for a video clip, the clip will break into eight pieces and each will transition off of the screen in a radial 
direction outward. The arrows work the same for the End clip on the right hand side except that clips move from
outwards to inwards.

The Faders
Faders are additional effects that can be added to the incoming and outgoing images. The Faders are Solid, 
Fade, Reverse Fade, Melt, Random, and Alpha.

Choosing Solid is the same as not choosing any fader.

The Fade fader causes a gradual and continuous color change to occur during the transition. It is commonly 
known as a dissolve.

The Reverse Fade causes the fade to operate backwards. This is usually used with one image to fade from a 
solid color. See Background Color, below.

Melt causes a fade based on the luminance values of the image or video clip. This causes the lighter parts of the 
source material to fade in first followed by the darker portions.

Random adds speckles of color that will either be the selected background color, or the color of the image 
beneath it, depending on the transition.

The Alpha fader is a very powerful feature and can produce wonderful transitions. The Alpha fader is used on 
32-bit start images to cause the opaque part of the image to fade before the transparent part. Using this 
technique you can design your own transitions (checkerboards, gradient, circular, etc.). To use the Alpha 
channel fader it is necessary to select Alpha for both the Start and End image faders. The Start image must be a 
32-bit image. For a discussion and explanation of Alpha channel images refer to tutorials 10-15, paying close 
attention to Tutorial 11 - Making Custom Faders Using 32-Bit Images.

The Background Color
The Background Color option allows you to choose background colors for transitions. These colors will also 
modulate some of the Faders. For instance, if you choose a background color of green and choose Random as a 
fader for a transition, the random speckles of color will appear green. If you only specify a start image and 
choose Reverse Fade, the image will fade from a shade of green into the start image.

The Transition List
The Transition List on the leftmost side of the Transition Editor lists the names of the most commonly used 
transitions. To use a particular transition that is listed, simply select a transition from the list.

The Overlay Filters



The Overlay Filter is used when one image or video clip is to be superimposed onto another. PhotoMorph 2 
provides six different ways to create overlays: Blue Screening, Chroma Keying, Luminance Keying, Alpha 
Channel Compositing, Texturizing, and Text overlays. When using the Overlay Filter, the Start and End 
materials must be the same size.

The Overlay Editor

Color Keying
The Chroma Key, Blue Screen, and Luminance Key filters are a family of similar effects. Each filter allows you 
to select a range of colors or brightness values and make those colors transparent to a background image. In 
other words, those colors in the Start image become transparent and the End image shows through. Blue Screen 
is the most commonly used effect - widely used in television and films. Typically, an actor is filmed against a 
blue background. The film editing process removes the blue background and substitutes an exciting picture like 
a view over a cliff. The actor wasn't filmed hanging over a cliff, the editing process made it look that way. 
PhotoMorph 2 can do exactly the same effect using the three color keying filters. The differences in the filters 
are listed:

Blue Screen allows you to key on a range of only blue colors and pass through shadows.

Chroma Key allows you to 'key' on, or select any color.

Luminance Key allows you to key on a range of luminance values, or brightness values instead of colors.

The color key features in PhotoMorph 2 are extremely powerful and very flexible. It is possible to blue screen 
an AVI clip onto another AVI clip. This means that you could have a moving actor blue screened onto a moving 
background. You can also mix still bitmaps with video clips. Don't forget that by using multiple layers of filters 
in a single clip you can composite four scenes with any three filters. It is possible to use all three color key 
filters in the same clip. For the exciting details, refer to Tutorial 8 - A Simple Example of Multiple Filter 
Layers.

Blue Screening 
The Blue Screen filter works only with blue colors. Three controls are available to adjust the key values of the 
blue color. That is, which shades of blue become transparent. The Lightness control allows you to set the 
lightest value of blue to become transparent and the Darkness control allows you to set the darkest value to 
become transparent. These controls allow you to set a light point and a dark point. Any shades of blue between 
these points become invisible. Any shades outside these values will remain visible in the resulting image of the 
Start and End images. The Shadow control allows a shadow in the blue screen to pass through and become a 
shadow in the resulting overlay. There must be a shadow in the blue color on the blue screen for this to function 



properly.

A common trick to producing high quality morphs is to film the objects to be morphed against a blue screen. 
After the morph is constructed, it is superimposed against a new    background. This way, the background does 
not interfere with the morphing process. This effect can be duplicated exactly by combining morphing and blue 
screening with    multiple layers of filters. 

Tutorial 4 - Creating a Blue Screen Overlay
Suppose you had a picture of a car that was filmed against a blue backdrop that you wanted to place against an 
image of a setting sun. This is easy to do with PhotoMorph 2.
1. Start PhotoMorph 2. If you already have PhotoMorph 2 running, choose New... Project    from the File 

menu.
2. In the Project Editor, open BLUECAR1.JPG as your start image. For your end image, load 

SUNSET.JPG.
3. Please note that we've already defined the blue screen for this image, BLUECAR1.JPG. Ideally, one 

would take the picture of the object against a blue screen. However, you can get acceptable results by 
painting the background blue on the image. When compositing video, it is highly recommended that the 
object be filmed against a blue screen, since it is very time consuming to hand paint every frame with a 
blue background. 

4. Select Overlay as your Filter Type and press Edit.
5. You will notice that Blue Screen has defaulted in the Overlay Editor. A preview shows the output that will 

be generated - in this case, the car against the sunset. Lightness, Darkness and Shadow controls allow you 
to adjust the filter. When finished, press OK.

6. Lastly, create the video and play it using the AVI Player.

Chroma Keying
The Chroma Key filter is more powerful than the Blue Screen filter because it can key on any color. It is a more 
general purpose tool and can do anything the Blue Screen filter can except transfer a shadow. Because it can do 
more things the controls are a little different. The biggest difference is the addition of the Eyedropper tool. This 
tool allows you to sample a key color in either the Start or End image. To use the eyedropper to select a color 
key you simply click on a part of the image. Once you have sampled this color you can adjust it further with the 
other controls. The Chroma tool allows you to select the key color manually. The Tolerance control allows you 
to adjust the range of the colors to key on. If the tolerance is set to very small, or all the way left, only a single 
color value can become transparent. If the tolerance level is very large, or all the way to the right, all colors can 
pass through and the complete Starting image will be transparent. The Darkness tool will also adjust the range 
of colors that are key colors. 

Luminance Keying
The Luminance Key filter allows you to key on a range of luminance values, or brightness, instead of actual 
colors. This is especially useful for keying on white, black, and shades of gray. It is also good for keying on 
pictures that have several colors of the same luminance. The Eyedropper tool will allow you to automatically 
select a starting luminance directly from an image. The Minimum control will set the darkest luminance value. 
The Maximum control will set the brightest luminance value. When using the eyedropper, the left mouse button 
selects the minimum value and the right mouse button selects the maximum value.

Note that blue screening, chroma keying, and luminance keying depend on chroma and luminance of the source 
material. Certain lossy compression algorithms reduce or remove this data from the images or videos being 
compressed. Thus, it may be difficult to get good results from materials that have been heavily compressed. For 
example, JPEG compression (including Motion JPEG) can cause these sorts of problems. To reduce this 
phenomenon, be sure to keep your compression quality settings as high as possible.

Alpha Channel
Alpha channel images can be used to create very interesting see-through and semitransparent filters. An alpha 
channel image is simply a 24-bit image with extra information, called a channel. Since an alpha channel uses 8 
bits of information, an alpha channel image is also called a 32-bit image. The Alpha channel determines the 



transparency of the image with respect to other images, specifying 256 levels of transparency varying from 
completely transparent to completely opaque. An alpha channel image with the alpha channel set completely off
would look exactly like a normal image. An alpha channel set completely on would be completely transparent to
any background image. The trick to using alpha channels is deciding what becomes transparent. 

Alpha channel images can be created in PhotoMorph 2 using the Colors/32-bit tool with the Image/Mask tool or
specified in the Filter Options of the Project Editor.

A complete discussion of Alpha Channels can be found in tutorials 9-14.

Texturize
The Texturize overlay takes the texture of the start image and applies it to the end image. This can be useful for 
creating imprints and other nifty effects. 

Text Overlay
The Text Overlay feature in PhotoMorph 2 allows titling of both video clips and images with TrueType and 
PostScript fonts. When using 24-bit source material, the font's color can be any of 16 Million colors. The 
interface allows real-time color changing, and font adjustment on the screen. 

To access the Text Overlay tool, place a video clip or bitmap in the Start image of the Project Editor, remove 
any image in the End position. Select the Overlay filter and click on Edit. The Text filter appears with the Style, 
Alignment, Color and Text box options. The Style option allows you to choose from any installed font styles 
and sizes. The Alignment option allows you to position your text at one of several preset areas on the image. It 
also allows you to choose between right justification, centered, or left justification. The Color option allows you
to select the color of your text. The Text box is where you type in the text that you wish to appear on the image. 
The text overlay will update the image with each keystroke. Text length is limited to one line of text.

The start image can be shown through the text by checking off the "Invert Text" option. When Alpha Channels 
are being used, additional options for applying text to the alpha channel are provided.

Some forms of video compression can make overlaid text (or any video content) appear fuzzy, smudged, or 
streaky. This is often the case with Indeo compression. If your text looks fuzzy when you play it back as an AVI 
file try re-rendering using Cinepak or Video 1.

Text overlay can be used to create some very interesting clips when used with other PhotoMorph 2 filters. For 
instance, you can overlay blue text onto a video clip or bitmap and use the Blue Screen filter to make each letter
invisible to a video clip that plays behind each letter. You can get very fancy with this filter by using the 
Distortion filters such as Zoom In, Zoom Out, and Rotate on the text. You can also create a tilted text filter by 
first rotating the bitmap, overlaying the text, and rotating it back. Always use high quality to preserve the image 
and text quality.

The Text Overlay tool is only available when one image is selected in the Project Editor.

The Distortion Filters
Video Distortions
The PhotoMorph 2 Distortions provide a great way to add truly unique effects to any video clip or bitmap. 
There are 22 Distortions to choose from, each can be rendered in low, medium, and high quality. Low quality 
renders very quickly and is good for previewing the effects. High quality is recommended for studio and 
broadcast videos. Click on the Animation Parameters button to access the Quality setting in the Project Editor.



The Distortion Editor

Several distortions can be combined in a single clip to create some really unbelievable effects. For example, the 
Rotation and Zoom In filters can be combined to create a spinning and growing effect. Rotation can be 
combined with Ripple on an Alpha Channel to make some really mind blowing pictures. 

Tutorial 5 - Using the Distortion Filters
Let's create a simple distortion filter on an image. While we're at it, we'll take a look at the Quality Settings in 
Animation Parameters.

1. Start PhotoMorph 2. If you already have PhotoMorph 2 running, choose Project, New from the File menu.

2. In the Project Editor, load OBOE.JPG as your start image.

3. Choose Distort as your Filter Type and press Edit.

4. A list of 22 pre-defined distortion filters is shown on the left hand side of the Distortion Editor. A number 
of settings appear on the right. Choose the Wave distortion filter and press OK.

5. Rather than creating a Animation, let's use the Preview window to examine the Wave distortion. Open the 
Preview window by pressing its button in the Project Editor (or choose it from the View Menu.)

6. Use the Percentage slider to see how the filter occurs. The image starts undistorted, then ends at full 
distortion. Close or minimize the Preview window.

7. Suppose we wanted to start with a distorted image, and then end up with the original image. Press Edit in 
the Project Editor. Engage Reverse Start Filter and press OK. Now access the Preview window again. The 
desired effect has been achieved, the image starts at full distortion, then undistorts into the original image.

8. Now let's use the distortion filter on two images to create a cross fade while the distortion occurs. Open 
GRLBRN.JPG as the end image. Press Edit to access the Distortion Editor. 

9. Notice the three new percentage controls on the right: Source, Merge, and Destination. These settings 
control cross fading during the distortion. Set Source to 33%, Merge to 34%, and Destination to 33%. 
Disengage Reverse Start Filter and turn on Reverse End Filter. Press OK and Preview.

10. As you slide the Percentage from left to right you will notice that the effect starts with OBOE.JPG, ends 
with GRLBRN.JPG, and waves in the middle. Why? We specified the Source (In this case, Oboe) to 



distort for 33%. Then a cross fade (or merge) occurs for the next 34%. Finally the last 33% is GRLBRN 
undistorting itself. Thus, the percentage settings control how the fade will occur. The Reverse Start and 
Reverse End settings control the direction the filter is going to occur.

11. Go back to the Project Editor. Access the Animation Parameters button; it's the third from the left and 
resembles a movie camera with two arrows pointing right. Once pressed, the right hand side of the Project 
Editor will open.

The Animation Parameters Button

12. On the bottom right of the Animation Parameters section you will notice a Quality setting. This setting 
controls the quality of PhotoMorph 2's output. Low quality renders quickly but may yield pixelated results. 
Rendering at medium quality takes longer, but yields better results. High quality rendering takes the 
longest, and is best suited for final production. Set Quality to high and update the Preview window (using 
the arrow button). Notice how much better the images appear. 

Some things to know about distortion effects:
1. The Distort filter can be used with either one image (load only a Start image) or two images (load Start and 

End images).

2. The Start and End percentages control when the Distort clip will begin and end recording to the output file.

3. If two images are being used, controls are provided for specifying different phases of the video: Source, 
Merge, and Destination. These controls allow sophisticated transition effects to be achieved.

4. Controls are also available for dictating the direction of the distortion:
Forward (undistorted image => distorted image) 
or Reverse (distorted image => undistorted image).

5. Distortion filter names followed by a [F] are particularly computationally intensive and will be slow on 
machines without a floating point co-processor.

6. All distortion filters can be rendered at each of three speed and quality settings: Low, Medium, and High. 
Low quality renders four times faster than Medium, and 16 times faster than High quality. Low quality is 
best suited to idea testing. High quality gives substantially better image detail and is best suited for a final 
render. The quality settings can be found in the Project Editor's Animation Parameters.

The Warp Filter
Imagine placing an image on a sheet of rubber and having the ability to stretch that image in any way. Warping 
allows you to do this, to stretch an image (or video clip).

Warps begin and end with different versions of the same image, therefore, only a Start image needs to be 
loaded. However, an End image may be loaded for use as a reference image (see below, Tips on Positioning 
Warp Point Pairs).

Tutorial 6 - Creating a Warp
Performing a warp is very similar to morphing; points are placed on an image and adjusted. Suppose we wanted
to illustrate a smart child. All we need to do is warp the child's head into an unnaturally large size. Let's try this 
with PhotoMorph 2. 



1. Open PhotoMorph 2. If you are already in PhotoMorph 2, select File / Project / New.

2. When warping, only a start image is required. In the Project Editor you will see two blank windows, 
labeled Start and End. Under each Window, you will see a drop down list. Once an image is chosen for the 
start and end images, <<No Image>> will be replaced with the file name of the image that you are working 
with. To the right of both drop down lists, you will find a small file folder button. Click on the one under 
the Start image.

3. Now you will be opening a start image. Change the 'List Files of Type', to JPG -JPEG Compressed. Click 
on LITLGIRL.JPG and press OK.

4. The Project Editor now should appear with a young girl in the Start window. Choose Warp as the Filter 
Type. 

5. Click on the Edit button. This will open the Morph/Warp Editor. As opposed to a morph, where both start 
and end images are used, a warp only stretches a single image. Thus, the End window in the Morph/Warp 
Editor is also filled with the image to be warped. Points are placed on the start image. As each point is 
placed, a second point is placed automatically on the end image. The placement of the point on the start 
image indicates the feature you want to stretch. By moving the point on the end image, you indicate the 
spot where the image is to be stretched to.

6. Notice the tool bar located to the left of both images. Each Button has a specific purpose:
a. The top button places points onto the images as explained below.
b. The second button moves points. The currently selected point can be moved with the mouse or with the

cursor keys.
c. The third button erases points.
d. The bottom button allows you to zoom in and out upon the image. Click on the image to zoom in, 

shift-click on the image to zoom out.

7. Note that this Window can be re-sized and "maximized" - just like most windows. By expanding the 
window, more of each image is shown.

8. The first feature we will stretch will be the forehead. Starting with a point directly under the left ear, place 
some points on the start image along the forehead. The last point should be directly underneath the right 
ear. With the exception of the two points under the ears, move the points along the forehead of the end 
image outward. The result should look like this:



This will cause the forehead to stretch outward.

9. Next, we'll tackle the hair line. Place points along the girl hair on the start image. Move those points 
outward on the end image, ensuring they are further outward than the points we've placed previously. The 
result should look like this:



10. Finally, we want to 'anchor' the eyebrows in place so that they do not stretch out unnaturally. Place a few 
points just above the eyebrows of the start image. Do not move them on the end image. This anchors each 
point in place. The result should look like this:  

11. Press OK and check your work using Preview. You'll find the Preview button on the Project Editor, seventh
from the left, that looks like a magnifying glass.

12. The Preview window appears. Use the slider to look through your video's frames. 

13. Once satisfied with your warp point placement, press Create Animation. A Save As... dialog box will 
appear. Name the AVI file and press OK.

14. After the rendering is finished, locate the AVI Player in the Project Editor control bar. Load your finished 
AVI file and press play!

Tips on Positioning Warp Point Pairs
As in creating morph clips, a good rule of thumb to follow for a warp clip is to place points on features in the 
image or images.

Since the Warp filter begins and ends with different version of the same image, only a Start image needs to be 
loaded. However, an End image may be loaded to use as a reference. 

For example, imagine that you wanted to warp an image of your face into another version which has the 
geometry of Arnold Schwarzenegger's face. Load the image of your face as the Start image, and load Arnold's 
face into the End image window. Then use the Warp Filter Editor to place points on the features of the faces, 
such as:

Edges/outline of eyes
Edges/outline of mouth
Along the hairline



Edges of the nose and ears
Along the outside edge of the head

... and any other specific features that are to be changed over the course of the warp.

When you create the warp video, your original face will warp into another version which has the same 
configuration as Arnold's face. Note, though, that Arnold's face (since it was loaded in the End image window) 
never actually appears in the finished warp.



USING THE STORYBOARD
The Storyboard is used to chain together clips of filters to create sequences of special filters. In fact, whole 
movies can be created using the storyboard feature of PhotoMorph 2.

The Project Editor, Showing the open Storyboard

Tutorial 7- Using the Storyboard to Create a Sequence of Effects
Suppose we wanted to create a video that does the following: morphs one car into a second, pauses for a 
moment, then has the second car transition back into the first. This sequence can be made using the Storyboard.

1. Start PhotoMorph 2. If you already have PhotoMorph 2 running, choose Project / New from the File menu.

2. Follow the steps in Tutorial 2 - Creating a Morph Movie, to create a clip of a car morphing into a second.
However, you do not need to create the finished video.

3. Nestled between the Start and End image windows of the Project Editor is the Create New Clip button. This
button resembles a film strip with an arrow pointing at it from an angle. Press it to create the second clip in 
this sequence. It will also open the Storyboard section of the Project Editor.

The Create New Clip Button
Please Note:

If your computer is currently in 640x480 display mode, the storyboard may not be completely visible. If 
this is the case, ensure the PhotoMorph 2 Window is Maximized. To automatically maximize PhotoMorph 
2 on startup, choose that option from the settings button in the Project Editor. To gain additional screen real 



estate, turn off    'Help/Status Bar' and 'Info/Status Bar' from the File / Setttings menu item. 

4. The second clip will start with the end image (BIGCAR2.JPG) from the previous clip. Our desired effect 
for this clip is simply to pause for two seconds. First we'll create the pause. Select Transition as the Filter 
Type and press Edit. Choose "Hold Constant" from the list of pre-defined transitions and press OK. This 
will hold the start image constant for the duration of the clip.

5. Now we'll set this to pause for two seconds. Open the Animation Parameters (see Tutorial 5- Using the 
Distortion Filters for more details). Notice the Frames Per Second (FPS) setting. This parameter allows 
you to specify the number of frames that should appear in every second of video. This setting applies to the 
entire video. Now notice the Frames setting next to the Edit button in the Project Editor. This parameter 
specifies the number of frames that is going to take place over the duration of the clip. This setting can be 
different for each clip in the storyboard. By adjusting these two parameters, the length of the clip is 
determined.

For example, suppose you desired to create a clip with a duration of two seconds. First, check the 
Animation Parameters section to determine the FPS setting. If this is set to 20 FPS, you need 40 frames to 
create two seconds of video. If this the FPS is set to 15, you need 30 frames to create two seconds of video. 

6. Determine the amount needed to create two seconds of video, and enter it into the Frames parameter in the 
Project Editor. Now the video will pause for two seconds.

7. Our final clip transitions from the second car back to the first. Press Create New Clip. The second car will 
remain as the start image. Using the drop down list under the End Image window, load the first car 
(SMLCAR2.JPG) as the End image.

8. Ensure that Transition is your Filter Type and press Edit. Choose a transition from the list (or make up your 
own) and press OK.

9. Change the Frames setting so that the transition will take one second. For example, if you are running at 20
FPS, set Frames to 20.

10. Press Create Animation to render and view your finished movie! 

More features of the Storyboard
The clip which is currently loaded in the Project Editor is outlined in red. The clip which has been clicked on 
(selected) in the Storyboard is outlined in blue. A tool bar is used to manipulate the position of a clip in the 
Storyboard.

The Storyboard Tool Bar
(From Left to Right: Begin, Left, Load Clip, Right, End, Cut, Copy, Paste)

Begin
The Begin button moves the selected clip (blue outline) to the beginning position in the Storyboard. This clip 
will now begin the video.

Left
The Left button moves the selected clip (blue outline) one position to the left.

Load Clip
The Load button reloads the selected clip (blue outline) back into the Project Editor. The clip will now be 
outlined in red, as the currently-loaded clip. You may also double-click on a clip to reload it into the Project 
Editor.



Right
The Right button moves the selected clip (blue outline) one position to the right.

End
The End button moves the selected clip (blue outline) to the ending position in the Storyboard. This clip will 
now end the video.

Cut
The Cut button removes the selected clip (blue outline) from the sequence of clips on the Storyboard and puts it 
on the Windows Clipboard. It may then be pasted into a different position in the current video, or into another 
video.

Copy
The Copy button puts a copy of the selected clip (blue outline) on the Clipboard. This clip may now be pasted 
into a different position in the current video, or into another video.

Paste
The Paste button inserts a clip from the Windows Clipboard. The clip will be inserted into the currently-selected
position (blue outline), and the other clips will be shifted to the right.

Toggling the Storyboard Display
One can show and hide the storyboard by pressing the Toggle Storyboard display button in the Project Editor. 
Note that this does not delete the contents of storyboard, it merely hides them from view. Use the Cut button to 
delete items from the storyboard.



ADVANCED TOPICS I: MULTIPLE FILTER LAYERS AND ALPHA CHANNEL COMPOSITING
This section is devoted to some of the advanced features of PhotoMorph 2. Although these features may appear 
intimidating at first, we have attempted to make each feature extremely powerful, while maintaining a 
straightforward, easy-to-use interface.

Multiple Filters
What are Filter Layers?
Imagine a composer working on a piece of music for three very talented musicians. Although each musician can
play only one instrument at a time, each musician can play any of six different instruments. Because each 
musician is an accomplished soloist, there will be portions of the piece of music that the composer will want 
only one musician to play. There will be other sections, however, in which the composer may wish to have a 
duet, or even all three musicians playing at once. 

Remember that each musician can play any of six instruments. Thus, the composer could have a section of 
music during which three trumpets play, then have another section in which the orchestration calls for flute, 
tuba, and bagpipe. Or he could have an electric guitar solo. This composer has many possibilities. 

Think of each PhotoMorph 2 filter (Colorize, Distort, Morph, Overlay, Transition and Warp) as one of the six 
instruments, the three filter layers as the three musicians, and yourself as the composer. Just as the composer 
would use different instrument combinations to create various musical textures, you can use different filter 
combinations to create various special effects. You have many possibilities.

Changing Filters
Switching between filter layers is very easy. Next to the Filter Type in the Project Editor is a button labeled 
[123]. This button acts as a toggle between the three layers. The currently-selected filter is highlighted in red. 
The second and third filters default to <<No Filter>>.

Tutorial 8 - A Simple Example of Multiple Filter Layers
1. Load a Start image. Set the Filter Type for the first layer to Colorize and click on Edit. Emboss will be the 

default filter. Slide the preview slider in the Colorize Editor to see how the resulting video will appear. The 
clip will start with the original image, and change to an embossed image. Since this is the desired result for 
our example, press OK.

2. Press [123] to advance to the second filter. The Start image will default to <<Filter 1>>. Remember that the
first layer is creating a dynamic emboss. Suppose we want to slide the image left as it embosses. Select 
Transition as the Filter Type and press Edit. Select Slide Left from the transition list and press OK. 

3. Now open the Preview window and slide the Percentage slider. You will see that the clip starts with the 
original image, and as the image is being embossed, it slides to the left. If you click on Create Animation, 
you can see the finished video clip.

This simple combination illustrates multi-layered filters very clearly. The second filter is layered atop the first. 
We can go another step and layer a third filter atop the first and second. We leave this as an exercise to the 
reader. (Hint: Try setting filter layer 3 in the above example to a Rotate distortion.)

It is important to note that although the result of the previous filter defaults to being the Start image, it can be 
used as the End image, as both the Start and End images, or not at all. In most cases the Start image default will 
be the most useful. Not using it at all may not appear terribly exciting, but as you'll see below, in the section on 
Filter Options, previous filters can be used to create dynamic Alpha Channel Masks.

Alpha Channels and Masking
What are Alpha Channels?
Imagine looking through a stained glass window. Light shines through some areas of the window, yet no light 
shines though other areas. One could say that certain portions of the window are transparent, where light clearly



shines through. Other portions are opaque, and no light shines through.

With PhotoMorph 2, one can construct a stained glass window atop any image or video clip. This window is 
known as an Alpha Channel. With an alpha channel one can control exactly which areas of an image become 
transparent when a second image is superimposed upon it.

Tutorial 9 - Increase to 32-Bit, The Difference Between Opaque and Transparent
Close any open Editor window. Load an image from the File menu, then choose the Colors menu. Under 32-Bit 
there are two options: Increase to 32-Bit (Opaque) and Increase to 32-Bit (Transparent). Choosing one of these 
options adds an alpha channel to the image. An Opaque Alpha Channel has no transparency, and therefore 
nothing will shine through the image. With a Transparent Alpha Channel, the image becomes completely clear, 
and when a second image is overlaid, the first image will disappear.

By default, PhotoMorph 2 displays "stripes" in the areas that are transparent. Thus, by selecting Increase to 32-
Bit (Transparent) the entire image becomes striped. When Increase to 32-Bit (Opaque) is chosen, the image 
does not become striped because no area of the image is transparent. The way alpha channels are displayed on 
images can be specified under the File/Settings menu.

32-bit images are said to contain alpha channel information. Only a few file formats can save this 
information: .BMP, .DIB, .TGA, and .TIF.

Tutorial 10 -Using the Image / Mask Menu to Construct Basic Alpha Channels
Once an image has been designated as a 32-bit image, the Mask option under the Image menu can be used to 
create basic transparencies on an image. Note that using mask menu is only one way to create an alpha channel. 
See Tutorial 14 - Dynamic Masks for more details.

1. Using the steps outlined above, load an image and increase it to be 32-Bit Transparent. This should result in
the image's becoming completely transparent, which is indicated by the striping. Next, select Mask from the
Image menu. 

2. On the left is a list of preset masks. On the right, the currently-selected mask appears. There are three 
options that can be selected: Invert Mask, Mask Alpha Channel, and Mask Color Channel. For our example,
select the Star mask. Ensure that Invert Mask is de-selected, Mask Alpha Channel is selected, and Mask 
Color Channel is de-selected. Click OK and look at the resulting image.

3. You will notice that the transparency, indicated by the striping, now takes the shape of the star. If you had 
selected Invert Mask, the opaque area of the image would be the interior of the star, and the exterior of the 
star would be transparent. Masking the Color Channel applies the mask to the image itself.

Now the part you've been waiting for; how to use alpha channels. We'll start with the Colorize filter.

4. Take the image created above, in which the star mask was used to create an image with some transparent 
portions and some opaque portions. Load this image as the Start image in the Project Editor. For your filter,
choose Colorize and click Edit.

5. You will notice that Emboss is the default filter. In the Preview window, you will note that the effect is only
being applied to the opaque areas of the image. The transparent areas (the areas that are striped) are not 
affected by the Emboss filter.

Even with this simple example, the power of alpha channels is illustrated. Portions of images can be masked 
out, so that specific areas of an image can be left unchanged.

Tutorial 11 -Making Custom Faders Using 32-Bit Images



1. With an alpha channel, one can create one's own transition fader. Use the same star image in the above 
examples as the Start image. Load an image that is of the same dimensions as the End image. Select 
Transition as your filter and click Edit.

2. The Transition Editor knows that the Start image contains an alpha channel and thus provides a fader under 
both images labeled Alpha. Select the Alpha fader under both images. Click OK and preview the video. As 
you slide the preview Percentage, you will see that the transparent areas fade between images first, then the
opaque areas fade.

As you'll see below, PhotoMorph 2 can use any image or AVI file as an alpha channel mask allowing you to 
create an infinite variety of faders. For a fun project in the meanwhile, try doing the same effect but instead of 
using the star to generate the Alpha Mask, use checkers. 

Alpha Channel Overlays
When using the Overlay Editor with a Start image containing an alpha channel, two more overlay types appear; 
Alpha and Inv. (Inverse) Alpha. These are used to provide control over the areas to be overlaid. 

Tutorial 12 -Making an Overlay With a 32-Bit Image
1. Load the star alpha channel image used previously into the Start image window of the Project Editor. Load 

a second image of the same size into the End image window. Select Overlay as your Filter Type and click 
Edit. Choose Alpha from the Type list.

2. You will see that the End image shines through the Start image in the shaded, transparent area. In the 
opaque area, the Start image shows. To reverse this, choose Inv. Alpha -- the area that is transparent 
becomes opaque, and the opaque areas become transparent.

Slider Explanation
You will notice two (or three as explained below) sliders for alpha channel control. The first is labeled Pre-
Alpha Fader. This slider controls the fade of areas that are not controlled by the Start image's alpha channel. 
Sliding the control to the left increases the Start image's transparency; all the way left is equivalent to 100% 
transparency.

The second and third sliders control the alpha channel of the resulting clip - this Overlay's output. These two 
sliders are useful when alpha channels need to be reused in multi-layer clips. Precise control of the resulting 
alpha channel is possible.

The second slider, labeled Post-Start Fader, controls the amount of transparency applied to the resultant clip, 
based upon the Start image's alpha channel. When the slider is placed all the way to the left, the resultant image 
is 100% transparent. With the slider set to the right, the resultant image will have the alpha channel from the 
Start image applied. Varying degrees of resultant transparencies can thus be achieved by adjusting the slider.

When the End image has an alpha channel, a third slider appears: Post-End Fader. This slider controls the 
amount of transparency applied to the resultant clip, based upon the End image's alpha channel. When the slider
is placed all the way to the left, the resultant image's alpha channel is that of the Start image. With the slider set 
to the right, the resultant image has the alpha channel from the End image combined with that of the Start image
such that the opaque areas of both alpha channels are combined. Varying degrees of resultant transparencies can
be achieved by adjusting the slider. To use the alpha channel of the End image alone, set the Post-Start Fader 
slider to the left, and the Post-End Fader slider to the right.

Varying the Transparency levels
Up to this point, we have only used basic alpha channels; the area is opaque, or its transparent - there is no 
"middle ground". Well, there can be! As there are shades of gray between black and white, there is a gradient 
between transparency and opacity. Since PhotoMorph 2 reads and uses 32-bit images created with PhotoShop, 
PhotoStyler, and 3D Studio, users of those programs can already reap the benefits of alpha channels without 
further instruction; simply load those images and use them as you did the images in the above examples. Some 



of us, however, aren't so fortunate. That's why PhotoMorph 2 allows anyone to use any image as a dynamic 
mask. Read on...

Tutorial 13 -Dynamic Masks
Through the use of the Filter Options, any image, any AVI file, and even the previous filter can be used to create
alpha channels.
1. Load Start and End images that are the same size but do not contain alpha channel information. Select 

Overlay as your Filter Type. Press Options. 

2. Under Alpha Masks (lower left hand corner of the window) you will notice places for Start and End 
images. Familiar Open Image file buttons appear next to each name. In a nutshell, one can specify another 
image, a video clip, or a previous filter to provide the alpha channel in varying degrees of transparency.

3. Let's continue this example, and then explain what's going on. Under Start choose any image (if need be, 
load an image using the Open Image button next to Start). Click on OK then click Edit in the Project Editor.
In the Overlay Editor, select Alpha from the type list.

4. The resulting preview might surprise you. The Start and End images are superimposed upon each other; the
amount of transparency being determined by the colors of the image used as the mask. You may wish to 
turn off Stripe Alpha Channel in the File / Settings menu to get the whole idea here.

Suppose we had used a monochrome (black and white) image as our Alpha Mask. If we had, the black areas in 
the image would indicate transparent spots, and the white areas would indicate opaque spots. If the masking 
image had been a grayscale image, the black areas would be used to make transparent areas. The white portions 
would be used to create opaque areas. The shades of gray would be used to create varying transparency levels 
(the darker the gray level, the more transparent the area, and vice versa). 

PhotoMorph 2 treated our color image as if it were a grayscale image. Thus, you will notice that where the 
masking image is dark in color, the End image shines through. Where the masking image is light in color, the 
Start image shines through. Remember, black or dark makes for a transparent area, and white or light makes for 
an opaque area.

Realize that any image can be used as a mask. For example, if we wanted to take one object in an image and 
place it on a different background, we would do the following: take a copy of the image into an image editor 
such as Paint. Next, paint black where you want the background to show. Paint white where you want the 
original image to show. After saving this image with a different filename (such as MyMask.BMP), start 
PhotoMorph 2. Load the original object as your start image. Load the background as the end image. Press 
Options and load your mask as the start mask. This will specify the transparent (black) areas and the opaque 
(white) areas. Finally choose Overlay as the filter type, press Edit, and choose Alpha as the Overlay type. The 
preview will indicate the desired result, an object in an image on a different background.    

Using AVI files as Alpha Channels
Because PhotoMorph 2 can treat AVI video clips in the same way it treats still images, one can create moving 
alpha channels. When a video clip is loaded into the Start or End mask section of the Filter Options, the Video 
Editing Options dialog is enabled for the masking AVI. Just like in the Project Editor, in and out points as well 
as sampling options can be specified. Consult the section on Video Editing Options elsewhere in this manual.

When a video clip is used as a mask, it is similar to using a color image, except the image changes over time. 
Where the video clip is dark in color, the End image shines through. Where the video clip is light in color, the 
Start image shines through. As with images, black or dark makes for a transparent area and white or light makes
for an opaque area.

Tutorial 14 -Using Other Filters as Alpha Channels
If you use the multiple filter layers, you will see that the previous filter can be used as a mask for a subsequent 



filter. As with images in the Project Editor, <<Filter 1>> and <<Filter 2>> can be used as input into the masks 
of, respectively, filter layer 2 and filter layer 3.

1. From the File menu, choose Project / New to clear out the Project Editor. Then close the Project Editor as 
well as any open image windows.

2. From the File menu, choose Open and load the image (not video clip) of your choice. From the Edit menu 
choose Copy to place the image you just loaded onto the Clipboard.

3. From the File menu, choose Image / New. This will create a new, blank image.

4. From the Edit menu, choose Paste, and the image from the clipboard will be pasted into the new image 
window.

5. From the Image menu, choose Mask. From the list, choose Star. Ensure Invert Mask is de-selected, click on
Mask Color, select Black, and click OK. Click OK to apply.

6. A second time, from the Image menu, choose Mask. From the list, choose Star. This time, select Invert 
Mask. Click on Mask Color, select White, and click OK. Click OK to apply the mask. The resulting image 
should be a white star surrounded by a black border. All we've done is create a black and white image to be 
used as a mask. Realize that we could have used any image editor to make this mask and that we can use 
any image as a mask. 

7. From the View Menu, choose Project Editor. In the drop-down image list under the Start image of the 
Project Editor, choose Image1 - the image that we just made. 

8. Set your filter to Distort, click Edit, choose Rotate from the distortion list, and click OK.

9. Open the Preview window and use the Percentage slider to verify that what is occurring in the first filter is 
a rotating, black and white, star.

10. Press [123] to advance to the second filter layer.

11. Under Start image, <<Filter 1>> is selected by default. Instead, use the drop-down list to select the image 
that you originally loaded in step 2.

12. Choose Colorize from the filter list and click Edit. From the list of filters, choose Emboss and click OK.

13. Click Options to open the Filter Options. 

14. Under Filter Percentage, choose Constant, 100%. This will apply the Emboss evenly throughout the video 
clip.

15. Under Alpha Masks, choose <<Filter 1>> as your Start Alpha Mask. This will use the rotating star that we 
created in the first filter layer as the alpha channel. Remember, the black areas will be transparent and the 
white areas will be opaque. Click OK.

16. Click Create Animation and give the AVI file any filename.

17. Once the AVI file is created, use the AVI Player to load and play.

Although there were a number of steps involved, the resulting video clip is impressive. Dynamic masks can be 
used to create spectacular effects. Some more experiments:

In the above example, use the same filter layer 1, but change the second layer to be a Reverse Zoom Out 
distortion filter applied to the first layer, <<Filter 1>>. In the third filter layer, use <<Filter 2>> as the mask 



against a static emboss. This way the star will zoom in from nowhere, as it is rotating.

Start with a completely white image as your Start image. Use the first filter layer to construct an Explode 
transition. Use the second filter layer to perform a Shear distortion onto <<Filter 1>>. For the third filter layer, 
use two images, Start and End, of the same size. Under Options, set the start mask to be <<Filter 2>>. Set the 
third filter layer to be Overlay on Alpha Channel. Render this one for a truly amazing transition. 



ADVANCED TOPICS II: MOTION MORPHING AND WARPING

Motion Morphing
Motion Morphing is a feature that works with video clips. It is the same effect as single-frame morphing except 
that you can morph between two AVI video clips. For example, you can morph a running tiger into a moving 
automobile. Motion Morphing is automatically selected if either the Start or End image is an AVI file. To 
perform a motion morph load two AVI files into the Project Editor, select Morph in the list of Filter Types, and 
click Edit. Motion morphing is different from single-frame morphing. If you are morphing an AVI with 30 
frames then there are 30 frames that need morph points. With single frame morphing there is only one frame. If 
you are new to morphing we recommend that you attempt some single-frame morphs before trying a motion 
morph. 

The Basic Process
Place points on the important features in the first frame of the Start and End AVI clips. Use the bottom slider to 
advance to the final frame of the clip. Adjust the points to match the movement of the AVI files on the last frame
of the Start and End AVI clips. Go back and adjust frames at infrequent intervals such as every 10 frames. Then 
start at the beginning and perform fine adjustments. When you are finished with point placement, you can adjust
the color movement within a morph using the Project Editor/Options/ Color Shift tool. You can also adjust the 
morph movement speed using the Options/ Movement Speed tool. You can also create a morph which is a 
constant blend of the Start and End image instead of a dynamic transition from Start to End image. This is also 
found in the Option/Filter Percentage tool. Simply choose between Variable and Constant. Variable is the 
default and is most common for morphing.

Smart Points
The points that you add by hand are called Real Points and can be identified by their default color of light blue 
and light green. You can add a Real point anywhere in an AVI clip. PhotoMorph 2 will duplicate that point by 
creating Smart Points on all following frames. Smart Points have a default color of dark blue if they have not 
been moved or adjusted, and are dark green if they have been moved. By creating Smart Points, PhotoMorph 2 
saves you the work of creating new points for each frame, letting you concentrate on the important task of fine 
tuning the placement of points. By doing adjustments every 10 frames or so you can make use of the automatic 
adjustments of the Smart Points. The Smart Points between the Real points will always adjust to the Real 
Points.

When deleting a Real Point or a Smart Point, all corresponding points after that point will be deleted but no 
points before it will be deleted. If you have a sequence in a motion morph that has a lot of movement, extra 
points may be needed just for that section. You can add Real Points, adjust the Smart Points for several frames, 
and delete the remaining points that are not needed.

Helpful Advice
To help you achieve best placement of morph points you should use the zoom tool to zoom in on a clip when 
placing points. Also, because motion morphing takes more time than single frame morphing you may wish to 
create a test morph with just a few points before spending a lot of time on a project. This process of gradual 
refinement is very good for starting with a rough idea and gradually perfecting it.

Motion Warping
Motion Warping is the same effect as single-frame warping except that you can warp all or some of the frames 
of a moving video clip. Motion Warping is automatically selected if you place an AVI clip in the Start image of 
the Project Editor and choose Warp from the list of Filter types. 

Smart Points
The amount of effort to create a motion warp is a bit more than is needed to create a single-frame warp. If you 
are warping a clip with 30 frames, there are 30 frames that need warping points. Rather than make you recreate 
30 frames of warping points, we have added Smart Points to help you get the job done. The process to create a 
motion warp is the same as creating a single-frame warp but with one additional step. First, click on Edit in the 
Project Editor to bring up the Morph/Warp Editor. Set your starting warp points in the first frame of your warp 



clip. These points that you create by hand are called Real Points. PhotoMorph 2 will create Smart Points on all 
following frames automatically, saving you a lot of work. You can add Real Points to any frame anywhere in a 
video clip, and Smart Points will be created automatically. 

Helpful Advice
If you delete a Real Point or a Smart Point, only the points on following frames will be deleted. You will find 
that most of the effort of a motion warp is in adjusting the Smart Points so that a smooth motion is created. This 
is very important since video images tend to move on each frame. In order for a motion warp to look good, the 
points should be moving on each frame. Again, PhotoMorph 2 has several features to make your work easier. 
All points are color coded to help you organize your work. Colors can be assigned to the following kinds of 
points: Active Real Point, Active Smart Point, Moved Real Point, Moved Smart Point, Unmoved Real Point, 
and Unmoved Smart Point. For images that have a color that conflicts or obscures the points you can easily 
change the color of that point type to be something else using the point color tool.

By specifying a constant setting in Filter Options, Smart Points can be used to create very exact warps. The 
motion of the points will determine the exact shape the warp will take over time.



IMAGE EDITING WITHIN PHOTOMORPH 2

Opening Image Files
Opening an image file reads in an image from your disk and displays it. Go to the File menu and choose Open. 
A dialog box will appear.

To see a list of available file formats, click on the down-arrow button next to the Files of Type list. Scroll the list
by clicking on the up and down scroll arrows. Click on the file format PCX - PC Paintbrush Format. 
PhotoMorph 2 will display all of the files in the current directory that are in the PCX format. If you want to see 
a list of all files in the directory, go to the top of the file formats list and choose * - List all files.

To open a file, double-click on its name in the file list. Try opening some of the sample images that are provided
with your copy of PhotoMorph 2. They can be found in the VidCraft folder.

Converting, Compressing, and Saving Images
After loading an image, you can use Image / Save As... in the File menu to convert the image to other formats 
and save it in compressed or decompressed form. Open the file COLORS1.TGA from your PhotoMorph 2 
directory. Now choose Image / Save As... from the File menu. A dialog box will appear.

If you wish to save the image to a new drive or directory, move to the new one by double-clicking with the 
mouse in the directories list box. Choose a new file format for the image by clicking on the new format's name 
in the formats list box. Try choosing the format TIF - Tagged Image File Format from the formats list box. Note 
that the output filename in the Filename edit box has been changed to COLORS1.TIF. You can use this edit box 
to change the output filename if you wish.

Instead of using the mouse to make changes, you may change the output filename and format by simply typing 
the new name in the Filename edit box. For example, to change the file COLORS1.TGA to a PCX file, type 
COLORS1.PCX in the Filename box.

You can also change the file's compression state when saving. Click on the Format>> button. Choose the 
Compressed radio button at the bottom to save your file in a compressed form. De-select the radio button to 
save the file in an uncompressed form. Note: There are some formats that cannot have their compression state 
changed by the user. For these formats, the Compressed radio button will be grayed out (disabled).

To save the file with your chosen parameters, click on the Save button. To cancel saving and exit the Save As... 
dialog box, click on the Cancel button.

In addition to being able to change filenames and compression states, the Save As... option in the File menu can 
change color configurations.

Color Reduction and Optimization - The Colors Menu
PhotoMorph 2 has sophisticated options for performing optimized color reductions on your images. There are 
two different ways to change color formats: 

Use the main Colors menu or the pop-up (right click) Colors menu.
Use the Image/Save As... option in the File menu.

With both of these methods, you may choose between two color reduction algorithms, Flat Cut and Optimized 
Cut, and you may choose whether or not to dither the image when reducing colors.

Using the colors menu, you may quickly choose a color configuration for your current image. 

Open the sample file, COLORS1.TGA. Now open the Colors menu and note that 24-Bit Color is checked. Click
on another color configuration; for example, 16 Colors. Now you may choose between Flat Cut, Optimized Cut,
Flat Cut with Dither, and Optimized Cut with Dither. Try choosing one of these options, then use the Undo 
option under the Edit menu to get the original image back. Then choose another method, then Undo, etc. This 



will give you an idea of the results each of the four methods will give you.

You can also try choosing Gray at the top of the Colors list to convert the image to grayscale.

For a shortcut to the Colors menu, right click on an image.

Screen Capture
The PhotoMorph 2 screen capture utility will prove very useful to you in creating screen images to use in 
videos.

The following sequence will capture an image of your entire screen and automatically paste it into a new 
PhotoMorph 2 window.

Go to the Capture menu and choose Entire Screen. Now click on Set Options... in the Capture menu. In the 
Capture group, choose To Window. Click OK.

Now simply hit the F11 key. PhotoMorph 2 captures an image of your screen, opens a new window, and pastes 
the image into it (all in one step!)

Feel free to explore the Capture menu to realize all of PhotoMorph 2's screen capture possibilities.

Printing
To print an image, simply open an image file and choose Print from the File menu. You can use the Print dialog 
box to scale, set print quality, and set up the printer. PhotoMorph 2 can print to any Windows-supported printing
device. 

If you wish to print a frame of a PhotoMorph 2 sequence, use the Save image to new window button in the 
Preview window. This will create a new image in the PhotoMorph 2 work area. Then, select the new image by 
clicking on it (close the Project Editor and Preview window if necessary) and chose Print from the File Menu.

The Edit Menu
Options for Cutting, Copying, and Pasting to the current image window are provided. Each menu item is 
detailed below.

Mistakes and Experiments: Undo
The Undo function under the Edit menu can be a lifesaver. It reverses the most recent operation performed on 
an image. Note that the Undo operation only applies to image windows, not to project windows!

Undo works on an image-by-image basis. In other words, if you have two images open, you can make a change 
to Image #1, then make a change to Image #2, then go back to Image #1, choose Undo, and get the original 
unchanged Image #1 back.

You can use Undo as a toggle between two versions of an image. Load an image, make a change, then use Undo
to switch back to the original image. Use Undo again to see the change again, and so forth.

Undo is a great tool for trying out various operations on an image. Try loading an image and performing the 
different color reduction options on it (Flat Cut, Optimized Cut, and the same two with dither), using the Colors 
menu.

Cut
This option clears the current image window and places that image on the Windows clipboard.

Copy
This option copies image from the current image window and places that image on the Windows clipboard.



Paste
This option takes the image that has been cut or copied to the clipboard (from PhotoMorph 2 or any other image
editor) and places that image into the current image window. To paste an image into a new window, choose 
Image, New from the file menu before pasting. 

Paste Palette
This handy feature pastes the palette from the image stored on the clipboard into the current image in 
PhotoMorph 2. This is extremely useful for ensuring that images share the same palette on 256 color displays.

The Image Menu - Instant Image Editing
With the Image menu, you can re-orient your image by rotating, change its size by cropping or scaling, and 
perform a variety of other operations such as inverting colors, mirroring, framing, tiling, captioning, and 
masking. Controls for contrast/brightness, hue/saturation provide a means of color correction for images. By 
combining these operations, you can achieve great-looking special effects, too.

Digital re-sampling methods are used to create very high-quality rotated and scaled images.

Invert Image
Use this menu item to invert the colors in your image. Invert Image creates a color negative by taking each of 
the original image colors, computing their opposite in the color spectrum, and changing each original color to its
opposite. 

Flip Image
Use this menu item to flip your image along the horizontal axis.

Mirror Image
Use this menu item to flip your image along the vertical axis, creating a mirror-image of the original.

Crop
Use this option to cut off portions from the sides of your image. The Crop dialog box lets you specify portions 
of the image you want to cut from top, bottom, left, and/or right. A thumbnail version of the image is included in
a previewing box at left. Use this to monitor your crop-line locations as you crop the image.

The Crop group in the dialog box has fields in which you can enter pixel values to crop off of the Top, Bottom, 
Left, and/or Right of your image. As you enter pixel values, crop lines will appear at the specified locations in 
the thumbnail previewing box.

Another way you can crop your image is to point with the mouse to a crop line in the previewing box (the 
cursor will change to a double-sided arrow), hold down the left mouse button, and drag the line to the new 
location. When you first open the Crop dialog, the crop lines are located at the edges of the image in the 
previewing box. As you drag, the pixel values in the Top, Bottom, Left, and Right fields will change 
dynamically. You can also point to a corner (a four-sided cursor appears) and drag the corner, to move two crop 
lines simultaneously. To move the entire crop-line box around the image, just point anywhere inside the box (the
cursor will change to a hand), click, and drag the box to its new location.

The new dimensions (in pixels) of the image will be displayed in the Dimensions group. The Dimensions group 
allows you to enter new pixel dimensions for the image in the Width and Height edit boxes. By default, the crop
lines will be centered on the image. For example, if you enter a Width value that is 20 pixels less than your 
original image's width, crop lines will appear 10 pixels in from the left and right edges of the image.
The Dimensions group is quite useful if you want your final cropped image to be of a specific size. Just enter 
the final dimensions in the Width and Height boxes. Then, if the crop lines are not where you'd like them to be, 
you can use the hand cursor to move the crop box around.

The Display group allows you to choose whether or not to preview your image at actual size. If your image is 
small enough that it fits entirely within the previewing box, the Show Real Size radio button will be 



permanently selected (since your image will automatically be previewed at full size).

Scale
The Scale Image dialog box allows you to: set a new width and/or height for the image; scale by percentage; 
choose high-quality or high-speed scaling; choose different units of measurement; specify dots-per-inch for 
different devices (allowing you to create predictable image sizes for particular devices, such as printers); and 
correct aspect ratio and resolution problems.

You may specify a new image size by typing values into the Width and/or Height fields. Use the Maintain 
Aspect check-box to choose whether or not to maintain the image's original aspect ratio (in this instance, aspect 
ratio means the ratio of image height to image width). If you select the Maintain Aspect check-box and then 
change either the Width or the Height value, the other value will change automatically, to preserve the same 
aspect ratio. If you de-select the Maintain Aspect check- box, and you enter Width and Height values that do not
preserve the original aspect ratio, the result will generally be an image that looks squashed or elongated.

The Measure list box allows you to change the resolution by which the scaled image is measured, enabling you 
to create images which are of a predictable size for a particular device. There are three choices: Screen (x, y), 
Printer (x, y), and Custom. The values in parentheses represent dots-per-inch (horizontal, vertical) for the 
chosen device.

The Quality list box lets you choose between High or Low quality for your scaled image. If you choose Low 
quality, the scaling operation will be fast, and the resulting image will not be as good as it could be. With Low 
quality, the scaled image will be created in the same color configuration (bits-per-pixel) as the original image. In
a High quality scaling operation, the scaled image will be created in 24-bit color (for color images) or in 8-bit 
grayscale (for gray or monochrome images).

Rotate
Use this menu item to rotate your image by any number of degrees, positive or negative, and to choose a 
background color for the rotated image.

Choose Custom, 90, 180, or 270 for degrees of rotation. If you choose Custom, you may enter any integer in the
Amount edit box, and your image will be rotated by that number of degrees. Rotation is to the right (clockwise) 
if the integer is positive, to the left (counterclockwise) if the integer is negative. You may use the Quality list 
box to choose between High and Low quality for the final rotated image.

If you are rotating the image by 90, 180, or 270 degrees, the quality will always be High (in other words, there 
will be no difference in appearance of the image or in speed of the operation, whether you choose High or Low 
quality). If you choose 90, 180, or 270 for degrees of rotation, the rotated image will be created in the same 
color configuration (bits-per-pixel) as the original image. For instance, if your original image was a 4-bit (16-
color) image and you rotate it by 180 degrees, the rotated image will be created as a 4-bit (16-color) image.

If you are rotating the image by any other number of degrees, you will be performing a Custom rotation. If you 
choose Low quality for a Custom rotation, the rotation operation will be fast, and the resulting image will not be
as good as it can be. With Low quality, the resulting image will be stored in the same color configuration (bits-
per-pixel) as the original image. If you choose High quality for a Custom rotation, the rotation operation will be 
slower, but the resulting image will look much better. In a High quality rotation, the rotated image will be 
created in 24-bit color (for color images) or in 8-bit grayscale (for gray or monochrome images).

The final quality of the rotated image is dependent on the image's resolution. One way to increase an image's 
resolution is to first use the Scale... operation to enlarge your image (say to 300%, or 3 times original size), then
perform the Rotate... operation, and finally scale the image back down to its original size. Working with the 
image at a higher resolution (larger size) will increase the quality of the image when it is shrunk back to its 
original size.

In a Custom rotation, the rotated image's dimensions will be larger than the original image's dimensions. 
(Rotate... draws a rectangle around the rotated image, with edges tangent to the rotated image's corners. You 



will thus have portions of "background" showing behind the rotated image.) You may choose a background 
color for the rotated image by clicking on the Color button. The background color may be chosen from a palette 
corresponding to your original image's color configuration (for monochrome images, choose black or white; for 
4-bit images, choose among 16 colors; etc.). If your original image was in 24-bit color, you may choose any 
color for the background.

When you click on the Color button, a color-chooser dialog box for the present color configuration appears 
(except for monochrome, where the color toggles between black and white). For 4-bit and 8-bit files, the color 
palette will have 16 colors and 256 colors to choose from, respectively. For 24-bit files, the standard Windows 
color-chooser dialog box appears. Note: If you are choosing a color for a 24-bit image, remember to check the 
luminance value in the color-chooser dialog (this can be adjusted with the slider on the far right). If luminance is
set to 0, your color will always come out black, and if it is set to 240 (the highest value), your color will always 
come out white.

Frame/Caption
Use this menu item to create a custom frame and to add a caption to an image. 

In the Frame/Caption Image dialog box, you will find options for choosing a frame style; specifying a framed 
image's final dimensions; specifying and previewing frame margin measurements; adding caption text; and 
choosing colors for frame fill, frame outline, and text.

From the Style list box, you may choose Filled or Outline as the frame style. Filled creates a frame filled with a 
specified color. Outline creates a frame with a one-pixel outline of a different color from the fill color. (Use the 
Color button to name a color for frame fill and frame outlines.)

In the Final Dimensions group, you may enter the dimensions, in pixels, of the finished image (picture plus 
frame). As you enter the picture's final dimensions, the Frame Margin values (see Frame Margins below) will 
change dynamically, centering the image within the frame. Please note: The Final Dimensions width and height 
values cannot be smaller than the width and height of the image you wish to frame. In other words, the frame 
cannot cover any part of the image but must only wrap around the outside of the image. If you want the finished
dimensions to be smaller, you should first use Crop... or Scale... to cut down the size of the image before 
framing it.

In the Frame Margins group, you may specify the width of the frame, in pixels, at the Top, Bottom, Left, and 
Right of the image. As you alter these values, the Final Dimensions values will change dynamically to show you
the final height and width of the framed image. A previewing box at the top right also changes dynamically as 
the Frame Margins values change. (The frame you've specified appears in black, while the hatch-marked area 
represents the framed image.)

Use the Colors group to choose colors for frame fill, frame outline, and caption text. In the drop-down list box, 
choose the area for which you want to pick a color (Fill Color, Outline Color, or Text Color), then choose the 
color with the Color button. Colors may be chosen from a palette corresponding to the original image's color 
configuration (except for 24-bit images, for which any color may be chosen).

When you click on the Color button, a color-chooser dialog box for the present color configuration appears 
(except for monochrome, where the color toggles between black and white). For 4-bit and 8-bit files, the color 
palette will have 16 colors and 256 colors to choose from, respectively. For 24-bit files, the standard Windows 
color-chooser dialog box appears. Note: If you are choosing a color for a 24-bit image, check the luminance 
value in this dialog (adjust with the slider on the far right). If luminance is set to 0, your color will always be 
black, and if it is set to 240 (the highest value), your color will always come out white.

In the Caption (x, y) group, you may enter any text you wish to overlay upon the image. (You are not required 
to create a frame in order to place text upon your image.) The x and y values that are displayed next to the word 
Caption represent the width and height (in pixels) of the caption that you create. This allows you to create a 
frame in which your caption will fit. If your caption does not fit in your frame or on your picture, the text will 
be truncated, not wrapped.



Click the Style button to select your font, font style (bold, italic, etc.), size, and effects. Choose a text color with 
the drop-down list box in the Colors group, click on Text Color, then pick a color with the Color button. (See 
above for information on the Color button.)

Click the Align button to position your text along the horizontal and vertical axes. Choose Left, Center, or Right
align in the Horizontal group, and Top, Center, or Bottom align in the Vertical group.

You should also consider the special effects you can achieve by combining various operations in the Image 
menu. For instance, to run a caption diagonally across your image, first rotate the image by 45 degrees, caption 
it, then rotate back to its original orientation.

The final appearance and quality of the framed image and caption text is dependent on the image's resolution. 
One way to increase an image's resolution is to use the Scale... operation to enlarge the image (say to 300%, or 3
times original size), then frame and/or caption it, and finally scale the image back down to its original size. 
Working with the image at a higher resolution (larger size) will increase the quality of the image when it returns 
to its original size.

Tile
Use this menu item to create multiple copies (tiles) of your original image and organize them in an array (as 
though the images were tiles being laid).

The Tile Image dialog box provides you with a Width and a Height field. Use these fields to specify how many 
tiles of the image you want along the horizontal (Width) and vertical (Height) dimensions.

Select the Mirror Tiles option to create mirror effects. This option will mirror tiles both along the horizontal and 
along the vertical axes. If you wish to mirror only along one axis, first tile along the mirrored axis with Mirror 
Tiles selected; then tile along the non-mirrored axis with Mirror Tiles de-selected.

Mask
Use this menu item to create special effects by masking out (hiding) parts of your image with the figures and 
patterns provided.

In the Mask Image dialog box, you can choose from an assortment of shapes for your mask. The Shape box at 
right will display the shape you choose from the Name list at left. By default, the black areas in the Shape box 
will be the areas through which your original image will show, and the white areas will be masked. If you select 
the Invert Mask option, however, the white areas in the preview box will be the areas through which your image
will show, and the black areas will be masked. Selecting Mask Alpha Channel will apply the mask only to the 
channel of a 32-bit image. Selecting Color Channel masks only the color part of a 32-bit image.

Use the Mask Color... button to choose a color for the masked parts of the final image. Colors may be chosen 
from a palette corresponding to your image's color configuration (i.e., black or white for a monochrome image, 
256 colors for an 8-bit image, etc.). If the original image is in 24-bit color, any color may be chosen for the 
mask color.

When you click on the Color button, a color-chooser dialog box for the present color configuration appears 
(except for monochrome, where the color toggles between black and white). For 4-bit and 8-bit files, the color 
palette will have 16 colors and 256 colors to choose from, respectively. For 24-bit files, the standard Windows 
color- chooser dialog box appears. Note: If you are choosing a color for a 24-bit image, remember to check the 
luminance value in the color-chooser dialog (this can be adjusted with the slider on the far right). If luminance is
set to 0, your color will always come out black, and if it is set to 240 (the highest value), your color will always 
come out white.

The final quality of the masked image is dependent on the image's resolution. One way to increase an image's 
resolution is to first use the Scale... operation to enlarge your image (say to 300%, or 3 times original size), then
mask the image, and finally scale the image back down to its original size. Working with the image at a higher 



resolution (larger size) will increase the quality of the image when it is reduced to its original size.

Contrast/Brightness
Use these menu items to increase the contrast and brightness of the selected image. Contrast will make dark 
parts of an image darker and will make light colors lighter. Brightness will make the entire image lighter. Use 
the slider controls to change the contrast and brightness on the preview image which is displayed. Then select 
OK to apply those changes to the image. You can use Channel to select the specific color plane you wish to 
modify or you can select RGB and change all colors with a single operation.

Hue/Saturation
Use the Hue and Saturation controls to change to overall Hue and Saturation of an image. 

The Filter Menu
PhotoMorph 2 comes with 11 filter effects which can give an image additional distinction and flair. A filter is 
applied to the image in the active window. This process can be repeated several times to give more of an effect. 
All filters work with images having 16 or more colors. If an image is only black and white, or monochrome, the 
filter menus will appear grayed out and will not be applicable. If you really need to apply a filter to a black-and-
white image you can promote the image to color using the Colors menu. The filter menu does not apply to AVI 
files. Use the Colorize effect to filter AVI files.

The Filter menu's effects appear in the following order:
Sharpen
The Sharpen filter makes a blurred image look more crisp. The opposite of Sharpen is Blur.

Sharpen Lines
The Sharpen Lines filter will accentuate lines and finer detail in an image.

Despeckle
The Despeckle filter will remove stray points of very different colors. This has a subtle smoothing effects.

Emboss
The Emboss is a very interesting effect which can make an image look like a three-dimensional relief, or 
sculpture. 

Blur
The Blur effect gives an image a blurry appearance. It is especially noticeable on very detailed images. As with 
all filters, it can be used repeatedly on an image to make it very blurry or a little blurry.

Median
The Median filter is used to create a Posterize effect where a few colors dominate an image.

Trace Edges
The Trace Edges filter will remove all features from an image accept its edges. Because of the nature of the 
filter, the colors it creates are very bright. These colors can be toned down or simply converted to gray using the
Contrast/Brightness or Hue/Saturation controls in the Image menu.

Noise
The Noise filter will add an amount of randomly colored pixels or 'visual noise' evenly over an image. If more 
noise is desired, the filter can be repeatedly applied as needed.

Maximum
The Maximum filter will increase bright or light colored areas in an image. Repeatedly applying this filter will 
spread the bright colors over an image much like water colors or finger paints.

Minimum



The Minimum filter is much like the Maximum filter except that it spreads dark colors. 

Old Movie
The Old Movie filter makes the image look like it was taken using and old style movie camera. This is also 
known as 'Sepia Tone'.



MORE OPTIONS: VIDEO EDITING AND FILTER OPTIONS 

Video Editing Options
The Video Editing Options tool allows you to specify a segment of frames to use within the current AVI file. 
The tool is located under the start and end image in the Project Editor and will become automatically enabled 
when an AVI video clip is loaded in that window. By setting the In Point and the Out Point, the portion of the 
clip to be used is specified, providing a means of performing simple editing, thus eliminating the need to use a 
separate editing program for anything but advanced editing. Also included in the Video Editing Options is the 
ability to specify how the source video is to be sampled. There are 3 options for sampling: By Time, By Frames 
and Whole Clip.

Sampling by Time means that PhotoMorph 2 should attempt to use the same amount of source video (in 
seconds) that is going to be created in the clip. If the clip contains 30 frames and is going to be written at 20 
frames-per-second, PhotoMorph 2 would try to take 1.5 seconds of video from the input AVI starting at the in-
point. If there are not enough frames between the in-point and the out-point to sample the proper amount of 
time, PhotoMorph 2 will switch over the Whole Clip sampling.

Sampling by Frames means that PhotoMorph 2 should attempt to match the input with the output frame-for-
frame. If the output is going to be 30 frames, PhotoMorph 2 should use 30 frames of the input video starting at 
the in-point. If there are not enough frames between the in-point and the out-point to sample the proper amount 
of time, PhotoMorph 2 will switch over the Whole Clip sampling.

Sampling Whole Clip means that PhotoMorph 2 will resample the frames between the in-point and the out-point
to match the number of frames that is going to be created by the clip. For example, if there are 10 frames 
between the in-point and the out-point and the clip is going to output 30 frames, each frame of the input video 
will be used 3 times.

Clip Options
The Clip Options dialog box has several features which can provide for greater control of the filters. 

Color Shift
The Color Shift control will adjust the speed that colors shift from the Start image to the End image. This is 
normally a linear transition but this too can be speed up or slowed down. A setting of 100 starts slowly and ends 
quickly. A setting of -100 starts quickly and ends slowly.

Movement Speed
Movement Speed is used to add acceleration or deceleration to a clip and for creating natural movements. A 
setting of 100 starts slowly and ends quickly; -100 starts quickly and ends slowly.

Filter Percentage
The Filter Percentage control determines how much of an effect will be applied. With the Variable setting, the 
filter will gradually increase from 0% to 100% across a clip. The Constant setting will fix a filter at a set 
percentage for the duration of the clip. This is useful for situations where you wish to hold a filter level constant
over the duration of an entire clip (like embossing and entire AVI file at 100%). Even though the filter level is 
kept constant the AVI file will still be sampled normally.

Alpha Masks
Alpha Masks allow you to use any image or AVI file as a temporary alpha channel without having to keep the 
alpha channel merged inside the source materials. Start allows you to specify an Alpha channel for the Start 
image, End allows you to specify an Alpha channel for the End image. When AVI's are used to provide alpha 
channel information, the Video Editing Options for that AVI will be enabled.



A GUIDE TO THE TUTORIALS 
Here is a list of the tutorials contained in this manual.

Tutorial 1 - Loading and Rendering an Existing PhotoMorph 2 Project
Primary Topic:

Loading and using PhotoMorph 2 Project (PMP) files
Other Topics Covered: 

Create Animation
AVI Player

Tutorial 2 - Creating a Morph Movie
Primary Topic: 

The Morph Editor
Other Topics Covered:

Loading Start and End images
Morph Points
The Preview window
Saving PhotoMorph 2 Project (PMP) files
Create Animation
AVI Player

Tutorial 3 - Using the Colorize Editor
Primary Topic:

The Colorize Editor
Other Topics Covered:

Loading Video Clips into the Project Editor
Clip Options, Holding an filter at a constant percentage

Tutorial 4 - Creating a Blue Screen Overlay
Primary Topic:

The Overlay Editor
Other Topics Covered:

Acquiring objects on a blue background.

Tutorial 5 - Using the Distortion Filters
Primary Topic:

The Distortion Editor
Other Topics Covered:

Animation Parameters - Quality Setting

Tutorial 6- Creating a Warp
Primary Topic:

The Warp Editor
Other Topics Covered:

The Preview window

Tutorial 7 - Using the Storyboard to Create a Sequence of Effects
Primary Topic: 

The Storyboard
Other Topics Covered:

Morphing
Creating Pauses in the Movie
Frames verses Frames Per Second
Transition Filters



Tutorial 8 - A Simple Example of Multiple Filter Layers
Primary Topic: 

Multiple Filter Layers
Other Topics Covered:

Colorize & Transition Filters

Tutorial 9 - Increase to 32-Bit, The Difference Between Opaque and Transparent
Primary Topic: 

The Colors Menu and Alpha Channels

Tutorial 10 - Using the Image / Mask Menu to Construct Basic Alpha Channels
Primary Topic: 

The Mask Menu Item and 32-Bit images
Other Topics Covered:

Colorizing 32-Bit Images

Tutorial 11 - Making Custom Faders Using 32-Bit Images
Primary Topic:

Alpha Faders in the Transition Filters

Tutorial 12 - Making an Overlay With a 32-Bit Image
Primary Topic:

Alpha & Inv. Alpha in the Overlay Editor

Tutorial 13 - Dynamic Masks
Primary Topic:

Using Clip Options to Specify the Alpha Channel

Tutorial 14 - Using Other Filters as Alpha Channels
Primary Topic:

Multiple Filters as Alpha Channels
Other Topics:

Image / Mask Menu
Distortion    and Colorize Filters



GLOSSARY OF TERMS

As with any technology, there is a set of terms that will be unfamiliar to the novice. Here, we'll define some of the 
terms that apply to digital video in general.

AVI file Frames Palette
Cinepak Frames Per Second (FPS) PhotoCD
CODEC Full Motion Video Resolution
Color Depth Graphics Display Adapter Scanner
Compression Algorithm Indeo Video 1
Data Rate Keyframes Video Capture Card
Feature Connector MPEG Video for Windows



An AVI file is a piece of digital video for the PC. It is sometimes referred to as a 'Video for Windows' file. This is 
because the Microsoft Video for Windows Runtime is required to play back the AVI file.



Cinepak is an algorithm used to compress AVI files. It was created by SuperMac.



CODEC is a acronym for COmpressor / DECompressor. See Compression Algorithm.



With computers there are various resolutions of colors. This is referred to as color depth. Examine the following 
chart:

Number of Colors Number of Bits Requires Palette
16 4 Y
256 8 Y
65,000 16 N
16,700,000 24 N

Thus, a 8-bit video card can only display 256 colors. A 24-bit video card can display 16,700,000 colors. To 
accommodate these various configurations, AVI files can be 8-bit, 16-bit, and 24-bit. However, a 24-bit AVI file will 
not look very good on a computer capable of displaying only 256 colors. Also, each 24-bit image will require more 
memory to store and process, since it contains all the color information for the image. Despite these drawbacks, 24-
bit color is the standard bill of fare for digital video. Simply put, the quality achieved with 24-bit color greatly 
outweighs the drawbacks of other color depths.    



Compression is needed so that the AVI file does not occupy large amounts of disk space. Three popular Video for 
Windows compressions are: Cinepak, Indeo, and Video 1. Because of the way Video for Windows works, any 
number of compression algorithms can be installed on a computer. Compression can even be done with specialized 
video capture cards. The only drawback is that if an AVI file is compressed using a given compression, that 
compression needs to be installed on every computer that is needed to play back that AVI file.



The data rate is the speed at which the computer has to achieve to properly play a given AVI file. Data rate is 
specified in Kilobytes per Second. Thus, an AVI file that has a data rate of 150 KB/Sec requires a computer that can 
process 150 Kilobytes of information in one second.



This is an attachment on the graphics display adapter that allows video signals to be passed to it without using the 
computer's regular path. Some video capture cards require that they be used with graphic display adapters that have 
a feature connector.



A video is made of a series of still images that are played in rapid succession to give the illusion of motion. Each 
image is called a frame.



The Frames Per Second setting specifies the number of frames a second of video is to contain. For example, if a 
video is made up of 30 frames, and the Frames Per Second is set to 30, that video will take one second to play. If a 
video consists of 30 frames and the Frames Per Second setting is 15, the video will take two seconds to play. FPS 
settings above 30 tend to be overkill and settings below 15 tend to look 'jerky'. 



Is usually defined as a video clip that has been recorded at 30 Frames Per Second.



This is the part of the computer that the monitor plugs into. Sometimes they are built into the computer's 
motherboard, others are separate cards. Graphics display adapters are sometimes referred to as video cards; this is 
not to be confused with video capture cards. A graphics display adapter that is optimized for digital video is often 
called a Graphics Accelerator.



Indeo is an algorithm used to compress AVI files. It was created by Intel.



A technique often used by compression algorithms is to store only the information that changes between each frame.
A keyframe is defined as a frame that has been stored in its entirety, as opposed to a series of changes. Typically, the 
user can define how often a keyframe is to occur.



MPEG stands for Motion Picture Experts Group. It is a hardware CODEC that provides VHS quality full screen, full
motion video. Currently, to play back MPEG compressed video files, special hardware is required. However, 
operating systems and computers are becoming more powerful. It is anticipated that the special hardware currently 
required to play MPEG will be superseded by software only playback on Pentium machines running Windows 95.



When an image with a low color depth is stored (i.e.: 8-Bit) a palette is used to tell the computer which 256 colors to
display. This means that two 256-color images can have two very different palette. If a graphics display adapter can 
only display a total of 256 colors, displaying one image at a time will not be problematic. However, if two images 
are to be displayed simultaneously on a 256 graphics display adapter, they must share the same palette if both 
images are to look correct.



This format was developed by Kodak to allow high quality photographs to be distributed on CD-ROM. A Photo CD 
can be viewed on a PC, Mac, or TV, provided the proper hardware is used.



This term refers to the dimensions of the digital video file. The units, in pixels, are usually evenly divisible by 20. 
320x240, 240x180 and 160x120 are three common resolutions for digital video.



A scanner converts pictures into computer data. Once scanned, a picture can be used to create digital video.



Video 1 is an algorithm used to compress AVI files. It was created by Microsoft.



A video capture card provides transfer of video from any video source into to the computer. As the video is played, 
the video capture card converts it into an AVI file. The AVI file can then be edited on the computer and used in any 
number of various applications.



Video for Windows is a standard for digital video on the PC developed by Microsoft. The file format for Video for 
Windows is AVI. Because it is not built in to Windows 3.1, Microsoft provides a free Video for Windows runtime to 
enable PC playback of digital video. Video for Windows runtime is built into Windows 95.



APPENDIX A - VIDEO COMPRESSION

Compression is needed so that the AVI file does not occupy large amounts of disk space. However, this is only 
part of the answer. Let's tie some of terms described above together to come to an understanding of the 
complicated issues surrounding compression.

Suppose for a moment that we are attempting to achieve full screen, full motion video. Because we want the 
highest quality possible, we intend to use no compression. Of course we want 24-bit color. Now, lets examine 
what that means:

1. A single frame of uncompressed video, full screen occupies about 1 Megabyte of disk space.
2. Since full motion means 30 frames per second, our video will eat 30 Megabytes of disk space with 

every second.
3. 60 seconds in a minute means one minute of video occupies 1800 Megabytes (That's almost 2 

Gigabytes!)

Obviously, with such large numbers something has to happen to make digital video work. Not only is large 
amounts of data required, the speed of the hard disk comes into play. In other words, the hard disk has to spin 
fast enough to play back this video in real time. Let's examine some alternatives:

1. We'll start with 1/4 screen video (320x240). Uncompressed with 24-bit color means .25 Meg a frame.
2. Rather than go all out with 30 FPS, let's scale that back to a more reasonable number, like 15 FPS. 

So .25 Meg times 15 equals 3.75 Megabytes per Second. Much better, but still a far cry from what we 
need...

What we need is compression, a method of storing data without using as much disk space. Compressors come in
two types: Hardware and Software. A hardware compressor is contained on a chip in either a video capture card,
or certain graphics accelerators. Hardware compression is usually very fast and yields excellent results. 
However, the AVI file will need to have access to that hardware compression every time it is to be played back. 
This is not a problem for people with a single computer who want to do digital video editing. However, this is 
not the solution for those who are developing a multimedia presentation that is going to be played on many 
different computers.

Software compression solves the distribution problem. Rather than relying on a specific piece of hardware, a 
software compressor can be used with any computer. The three popular software compressors are: Indeo by 
Intel, Cinepak by SuperMac, and Video 1 by Microsoft. All three are provide free with Video for Windows. 
Let's examine the advantages and disadvantages of these three compressors.

Indeo version 3.2, is Intel's video compressor. It compresses video quickly, however the quality can sometimes 
be less than admirable. Indeo will only compress to 24-Bit color. Intel has recently released version 4.1 of 
Indeo, which is capable of full screen, full motion playback.

Cinepak generally exceeds Indeo's quality, but at a price; Cinepak takes much longer to compress. Cinepak is 
best suited for final renders of complete video sequences. Like Indeo, it will only compress to 24-Bit color.

Video 1's only advantage is that it compresses to 8-bit, 16-bit, and 24-bit color. It compresses as fast as Indeo, 
and yields high quality. Unfortunately, it is unable to compress sufficiently to achieve a good data rate.

Data rate is the speed at which the computer has to achieve to properly play a given AVI file. In english, certain 
parts of your computer are faster than others. You may have a CPU rated at 40 Megahertz, a double speed CD-
ROM drive, an Enhanced IDE hard drive; but what does it all mean? Data Rate is what it all means. The faster 
your computer can go, the more productive you will be. The data rate specifies how fast your computer can go.

Here are some typical data rates for various components of a typical computer. Data rate is specified in 
Kilobytes per Second. 1000 Kilobytes is equal to a Megabyte. 

Device                                Typical Data Rate
Single Speed CD-ROM 150 KB/Sec



Double Speed CD-ROM 300 KB/Sec
Slow Hard Disk 500 KB/Sec

If you followed the math in our previous example, where we took a quarter screen (320x240), 15 FPS digital 
video file and saw that the uncompressed file would use a 3.75 Megabytes of disk space every second. This 
means, to achieve real time playback the    must be 3750 KB/Sec! This is much more than a typical hard disk 
can handle. This is why compression is so important to digital video. It provides a means that allow the 
computer to store the video in a relatively small amount of space, and it allows standard hard disks and CD-
ROM's to be used for real time playback.

All digital video compressors (also called CODECs ), are 'lossy'. This means that some quality is lost when the 
compression takes place. The more compression that is needed, the lower the quality. The best way to use a 
compressor is to determine the maximum    the playback platform is capable of achieving. Then, specify this    to
the compressor when generating the AVI file. By doing this, the compression algorithm will compress the AVI 
file until the desired    is achieved. The more it has to compress, the lower the quality of the finished result.





APPENDIX B - IMAGE SIZING AND CONVERSION

Color Reduction and Optimization
PhotoMorph 2 has sophisticated options for changing the color configuration of your images.    There are two 
different ways to change color formats:    

Use the main Colors menu or the pop-up Colors menu.
Use the Image/Save As... option in the File menu.

With both of these methods, you may choose between two color reduction algorithms, Flat Cut and Optimized 
Cut, and you may choose whether or not to dither the image when reducing colors.

The Colors Menu
Using this menu, you may quickly choose a color configuration for your current image.    The current 
configuration will be indicated in the menu with a check-mark. Open the sample file, COLORS1.TGA.    Now 
open the Colors menu and note that 24-Bit Color is checked.    Click on another color configuration; for 
example, 16 Colors.    Now you may choose between Flat Cut, Optimized Cut, Flat Cut with Dither, and 
Optimized Cut with Dither.    Try choosing one of these options, then use the Undo option under the Edit menu 
to get the original image back.    Then choose another method, then Undo, etc.    This will give you an idea of the
results each of the four methods will give you. You can also try choosing Gray at the top of the Colors list to 
convert the image to grayscale.

Pop-Up Colors Menu
A short-cut method of using the Colors menu:    open an image, then point to the image with the mouse and hold
down the left button.    The Colors menu will appear as a pop-up.    Choose your options in the same manner as 
above.

Save As...
In addition to being able to change filenames and compression states, the Save As... option in the File menu can 
change color configurations.

Open the file COLORS1.TGA.    Choose Save As... under the File menu.    Click on the Format>> button.    Note
that 24-Bit Bitmap, Color, and Compressed radio buttons are selected, showing the current configuration of the 
file.    Note also that the Monochrome Bitmap and the 16-Color Bitmap are grayed out (disabled).    This is 
because those two color configurations are illegal for the current file format, Targa (in other words, Targa does 
not support them).

Now try going to the file formats list and choosing the TIF format.    Notice that now all six color configurations
are enabled, since the TIF format supports them all.

You should notice that if you use the Save As... dialog box to convert files, there is no way to specify the color 
reduction method (Flat Cut or Optimized Cut) or to select/de-select dithering.    When a file is converted using 
Save As..., PhotoMorph 2 uses the methods that are specified in the Settings dialog box under the File menu.    
To change the file saving settings for Save As..., go to Settings and find the File Saving group.

If you choose a color configuration with fewer colors than the original image (anything less than 24-bit color, in
this case), PhotoMorph 2 will use the File Saving specifications when saving the file.    However, if you choose 
a configuration with more colors than the original image (i.e., 32-Bit Bitmap in this case), PhotoMorph 2 simply
stores the image in that color format.    No color information is discarded in this case.

Here are a couple of real-life examples:

Example #1:    You paste an image from the Clipboard which was taken from a Targa file.    Targa images 
can contain as many as 16 million colors (24-bit color).    You choose Save As... from the File menu.    You 
choose the RLE format from the file formats list, then click Save.    At this point, a color reduction must be 
performed (since RLE does not have a 24-bit color format).    PhotoMorph 2 will use the information in 



Settings to tell it which method of color reduction to use, whether to dither or not, and whether or not to 
display a warning that a color loss is about to occur.

Example #2:    You load a 16-bit color image which is in the TIFF format.    You choose Save As... from the 
File menu.    You choose the DIB format from the file formats list, then click Save.    DIB does not have a 
16-bit color format, but it does have a 24-bit color format.    In this case, PhotoMorph 2 will save the image 
as a 24-bit DIB.    No warning will be issued since no color information was discarded.

Important Note on compressing image files:    
You'll notice that with certain file formats, the Compressed option is grayed out.    There are actually four 
possibilities for file formats with regard to compression:

1. The format is always compressed (i.e., RLE).    The Compressed option will be grayed out and 
selected for these formats.

2. The format cannot be compressed (i.e., BMP).    The Compressed option will be grayed out and de-
selected for these formats.

3. Some subformats cannot be compressed and others can be either compressed or uncompressed (i.e., 
24-bit DIBs cannot be compressed, but 8-bit DIBs can be in either compression state).    The 
Compressed option will be grayed out and de-selected for the subformats that cannot be compressed,
and enabled for those that can be compressed or uncompressed.

4. The format can be compressed or uncompressed (i.e., TGA).    The Compressed option will be 
enabled for these formats.

All you need to do to compress an image is to turn on the Compressed option under Save As... when you save 
the image.    The image's specific file format dictates which compression algorithm PhotoMorph 2 will use (with
the exception of the TIFF file format).

For TIFF files only, you may change the default compression algorithm that PhotoMorph 2 will use when 
saving the file in compressed form.    A different algorithm can be specified for each color configuration 
(monochrome, 16 colors, 256 colors, 16-bit, and 24-bit/32-bit).    Use Settings in the File menu to change the 
compression defaults for TIFF files.

Using the File / Settings for Images
Use the Settings options to customize certain PhotoMorph 2 conversion operations to suit your individual needs.
These options affect speed and/or quality of the operations in question.    You can set options affecting screen 
bitmap use, color matching methods, dithering methods, TIFF file compression, default color reduction 
operations during file saving, and alpha channel display options.    The options you set will be saved from run to 
run of PhotoMorph 2.

Screen Bitmaps
A screen bitmap is a device-specific copy of the image you are viewing.    If you use screen bitmaps, you 
will substantially speed up all your screen updating.    The cost of using screen bitmaps is extra memory, so 
if you are using mostly large or high-color images, you may wish to turn this option off to avoid using too 
much memory.

If you have screen bitmaps turned on but PhotoMorph 2 cannot create a screen bitmap because memory is 
too low, a "Memory Getting Low" message will be posted.    The screen bitmap will not be created, so 
updating of the image will be slower.

Use on all images - Choose this option, and PhotoMorph 2 will use screen bitmaps on each image you load.
Don't use on 16-bit and 24-bit images - This option disables screen bitmaps for high-color images.    The 

memory you save allows you to load a greater number of images, as well as larger files.    Screen 
updates will be slower for 16-bit and 24-bit images.

Don't use on any image - Disable screen bitmaps with this option.    You will conserve memory at the cost 



of slowing screen updates.

TIFF Compression
This option allows you to set the default file compression algorithm to be used when saving TIFF files.    
You may choose a default compression algorithm for each possible color type:    monochrome, 16 colors, 
256 colors, 16-bit color, and 24-bit/32-bit color.    The compression algorithm PackBits (RLE) is available 
for all color types.    Group 4 (CCITT Fax 4) is available only for monochrome TIFFs. The default 
compression setting for all color types is PackBits. Note that LZW compression is not supported. This is 
due to an unreasonable lisencing arrangement required by Unisys Corporation, the patent holder for LZW 
compression.

Color
The Color: field can be used to specify how PhotoMorph 2 should display higher-color images on lower-
color devices.    There are two options:

Best Match - Best Match will attempt to match the image's original colors to the available system colors.
Halftone - If you choose Halftone, the image will generally look better, but the display operation will take 

longer.

Dither
There are eight different dithering algorithms for you to choose from: Halftone; NCS Fast
Floyd-Steinberg; Stucki; Burkes; Sierra; Jarvis, Judice, + Ninke; Stevenson + Arce.
There are no hard-and-fast rules for choosing a dithering algorithm.    The results will vary, depending on 
such variables as the image's number of colors and objects, the specific colors used in the image, and your 
intended final use of the image.

Keep UNDO Buffers
If you really need to conserve memory, you can de-select this option.    Undo buffers will not be saved, thus 
some memory will be freed.    Be warned:    If you turn this option off, then the Undo operation of the Edit 
menu will not function! The default setting for Keep UNDO Buffers is on.

File Saving
Use this option to set defaults for the conversion operations that occur automatically when you convert and 
save a file to a format with fewer colors.    You have the following options: choose between Flat Cut and 
Optimized Cut color reduction, turn dithering on or off, and to send a warning (or not) if you are about to 
sustain a color loss when saving an image.

Alpha Display Options
These options will determine how PhotoMorph 2 displays a 32-bit Alpha Channel image.    The default is 
Stripe Alpha Channel.
No Alpha Channel - The transparent part of the image is displayed in black, the opaque part is displayed 

normally.
Half Alpha Channel - The Transparent parts of the image are displayed at half-luminance.    The opaque 

parts are displayed normally.
Full Alpha Channel - The images is displayed as if it had no alpha channel.
Stripe Alpha Channel - Stripes are displayed where the alpha channel is transparent, and no stripes where it 

is opaque.

Correcting Resolution and Aspect Ratio Problems
Resolution
There's a possibility that Windows may enter an incorrect resolution for your screen in the Measure: list box 
under Screen (x, y) when scaling images. If it seems to you that the resolution values are incorrect, you can use 
the Custom entry in the Measure: list box to enter your monitor's actual resolution.

To figure out your monitor's actual resolution:    Measure the width of your monitor along the top or bottom of 
the screen (you can just use a regular ruler).    As an example, assume the width is 10 inches.    Now measure the 



screen's height.    Assume the height is 7.125 inches.

If you are running a VGA device, the resolution of your device driver is 640 x 480 pixels (width x height).    
Divide your device's pixel height (640) by the physical height of your screen to get your screen's dots-per-inch 
along the height dimension:

640 / 10 = 64 dpi
Divide your device's pixel width (480) by the physical width of your screen to get your screen's dots-per-inch 
along the width dimension:

480 / 7.125 = 67 dpi.
Now you can plug these numbers into the Custom Height and Width fields and create accurately-measured 
images for your screen.

Aspect Ratio
One common problem you may encounter when moving images from one display device to another is the 
change in aspect ratio.    Aspect ratio, as the term is used in this manual, is the ratio of a device's dpi (dots-per-
inch) along its height to dpi along its width.    If an image is displayed on a device that has a different dpi value 
along one or both axes than the device on which the image was created, its aspect ratio will be incorrect.    The 
image will generally appear either squashed or elongated.    There are two common operations that are often 
desired when working with devices that have different aspect ratios:    converting an image to have the same 
absolute size on the new device, and converting the image to have the same relative aspect ratio.

Same Absolute Size
To convert an image to the same absolute size on a new device you must know the absolute size of both display 
devices as well as the devices' pixel resolutions.    This allows you to compute the device-independent dpi 
resolution for each device.    Once the dpi is known it is a simple matter to scale the image to the proper size.

As an example, imagine that you have a picture of dimensions 160 pixels wide by 58 pixels high.    The picture 
was created on a CGA device with a monitor that measures 10 inches wide by 7 inches high.    CGA pixel 
resolution is 640 x 200.    So the CGA device's resolution (dots-per-inch) would be:

200 pixels / 7 in = 28.57 dpi along its height
640 pixels / 10 in = 64.00 dpi along its width

On this device, the picture's physical dimensions would be:
58 pixels / 28.57 dpi = 2.03 inches high
160 pixels / 64 dpi = 2.50 inches wide

If we use a Super VGA device with a pixel resolution of 640 x 480 (assuming the same-sized monitor as the 
CGA display), its resolution (dpi) would be:

480 pixels / 7 in = 68.57 dpi along its height
640 pixels / 10 in = 64.00 dpi along its width

Now, imagine that you display the CGA-created image on the Super VGA device (still assuming both monitors 
are 10 x 7 inches).    The picture, of course, still measures 160 pixels wide and 58 pixels high.    However, on the 
VGA device, its physical dimensions would be:

58 pixels / 68.57 dpi = 0.85 inches high
160 pixels / 64.00 dpi = 2.50 inches wide

So, without correcting for the different aspect ratio, the image would appear very squashed on the VGA.

To make the image have the same absolute size on the VGA device you must start out with the original size on 
the CGA device, and from there work out the new pixel size using the device-independent dpi information.    
Since, in this case, both devices happen to have the same dpi along the dimension of width, you only need to 
alter the image's height.    To get the desired height of 2.03 inches, given the VGA's height dpi of 68.57, you 
would multiply dpi by inches to get the pixel height:

68.57 dpi * 2.03 in = 139 pixels



So the image needs to be 139 pixels high on the new device to be the same size as it was on the old device.

To perform this action on the actual image, you would go to the Scale dialog box, de-select Maintain Aspect, 
and enter 139 in the Height: box.    Now your image will be 2.03 x 2.5 inches and will no longer look squashed.

Same Relative Aspect Ratio
Although there are an infinite number of ways to convert an image so that it has a particular aspect ratio (1:2, 
2:4, 3:6, etc.), the most commonly-desired results are for an image to maintain either the same height or the 
same width (measured in pixels).    This can be accomplished by computing the dpi resolutions of the two 
devices and then computing a new height or width.

As an example, let's say you have an image created on a CGA device which has dimensions of 320 pixels wide 
by 200 pixels high.    You want to save it as a VGA image with a height of 200 pixels (the same pixel height as 
the old CGA image), and to correct its aspect ratio.    So you need to find the width, in pixels, which will 
produce an image with the new VGA aspect ratio, given a height of 200 pixels.    Using the same CGA/VGA 
data as above you have aspect ratios of:

VGA: 68.57 dpi / 64.00 dpi = 1.07
CGA: 28.57 dpi / 64.00 dpi = 0.45

Now, to keep the height the same and compute a new width you would have:

320 x    (0.45/1.07) = 134

To keep the width the same and compute a new height, you would have:

200 x (1.07/0.45) = 475

To accomplish this last aspect change in PhotoMorph 2 you would go to the Scale dialog box, de-select 
Maintain Aspect, choose Pixels as the unit of measure, and enter the new height (475) in the Height: edit box.

Methods of Color Reduction
Reducing the number of colors in an image can be valuable for many reasons.    High-color images require a lot 
of disk space, so reducing the number of colors is one way of saving space.    Also, many output devices have a 
rather limited number of colors available for display, and using color reduction with dithering can vastly 
improve the appearance of high-color images on these types of boards. 

PhotoMorph 2 has two methods available to reduce the number of colors in an image:    Flat Cut and Optimized 
Cut.    Note:    It is important to realize that when a color reduction is performed on a high-color image, color 
information is lost (discarded) at that point.

Flat Cut can be used to reduce colors to 16-bit color (32,767 colors), 256 colors, 16 colors or monochrome.    It 
uses a simple algorithm for color reduction, creating a uniform distribution of colors across the visible spectrum.
It then uses this set of colors and matches them as closely as possible to the image's original colors.

Optimized Cut can be used to reduce to 256 or 16 colors.    The Optimized Cut algorithm may produce results 
far superior to the Flat Cut algorithm (depending on the image).    Optimized Cut is a method to determine the 
most important colors in the particular image you're working with.    It creates a custom palette which will 
optimize the appearance of that certain image.    

Dithering
Dithering is an extremely useful tool for color management.    It can be used with both the Flat Cut and 
Optimized Cut methods of color reduction.

In a nutshell, dithering increases the apparent number of colors in an image by reducing the apparent resolution 
of the video screen.    How does this work?    Dithering uses patterns of different-colored pixels which cause you
to perceive a blended color.    For example, an area filled with an alternating pattern of red and blue pixels will 



be perceived as being purple.    Therefore, the image appears to have more colors than it actually contains.    The 
flip side of using this technique is that the "purple" area will appear slightly more blurry or grainy to you than if 
it were composed of truly purple pixels.

Palettes
A palette is an assortment of colors that can be used to draw an image.    There is an important distinction 
between a device palette and an image which has a palette included in its information.
A device palette is a palette of colors that a particular device has available for use in displaying images.    If the 
device's palette is fixed, the colors must be chosen from the same palette for any image displayed.    If the 
device's palette can be set, then there is more flexibility in choosing colors.
An image may have a palette included in its information.    This means that the palette of colors used in the 
image is actually encoded into the image's data.

The distinction between the device palette and an image's palette may be illustrated in this example.    Suppose 
you have an image which is drawn in sixteen shades of blue.    The image's palette, which is included in the data,
consists of these sixteen different blues.    Now imagine you have a device which has a fixed 16-color palette, 
which includes colors distributed over the range of the visible spectrum.    When you display the image on this 
system, the device can only use the shades of blue in its fixed palette (in a standard 16-color palette, there would
be two shades of blue to choose from).    It will display the image using only its palette's two blues.    Obviously, 
the image's appearance will have deteriorated.    (However, no color information has been lost, since the 
information was encoded in the image itself.    It is only the display device's limitations that have affected the 
image's appearance.)

Now, imagine that you display the same image using a device with a 16-color custom palette.    Since the colors 
in a custom palette can be set, the device can accommodate this image by setting its own palette to the sixteen 
blues in the image's palette.    In this case, the display device can take full advantage of the image's palette 
information and can show the original colors accurately.
It should be mentioned here that Windows does not support a custom palette for 16-color devices.    However, 
there are non-Windows applications that do support 16-color custom palettes. 

PhotoMorph 2 can create custom palettes for images using the Optimized Cut color reduction algorithm.    
Optimized Cut and the other color reduction algorithm, Flat Cut, are described in the Methods of Color 
Reduction section.

How Color Configurations of Display Devices Affect Color Reduction
In this discussion, we emphasize the impact that your device's color configuration has on your choice of color 
reduction methods.

Monochrome
Monochrome is otherwise known as black-and-white.
Since monochrome displays have only two colors available, there's a very limited amount of subtlety you 
can achieve in displaying images.    The Flat Cut color reduction algorithm is sufficient for any reduction to 
monochrome.

16 Colors
If you're running Windows and have a 16-color board, the palette is fixed.    However, some non-Windows 
programs have custom 16-color palettes.    You can take advantage of that capability by using Optimized 
Cut and then transferring the color-reduced image into the other program.
If you want to use Windows and display an image that originally had more than 16 colors, you will get the 
best possible results if you use Flat Cut and dither the image to 16 colors.

256 Colors
When you are running PhotoMorph 2 with a 256-color video board and Windows driver, 256 colors are 
available for any and all images being displayed at any one time.    With the Optimized Cut color reduction 
algorithm, PhotoMorph 2 can custom-set the 256 palette colors to conform to a particular image's original 
colors, so as to produce the best-looking image possible.    Dithering will also improve the image's 



appearance.

If you use Flat Cut color reduction, the new palette will be composed of 256 colors evenly spaced 
throughout the visible spectrum.    Depending on what you intend to use your image for, this may be the 
option you want (though generally a custom palette will produce better-looking images).    You may also use
dithering with Flat Cut to improve the image's appearance.

If you use the Optimized Cut algorithm to reduce an image's colors, it may look slightly different if you 
display it under Windows than if you display it with a non-Windows application.    This is because 
Windows reserves 20 colors of the 256-color palette for its own use.    Since these 20 fixed colors will likely
not be included in the custom 256-color palette of the image, they will "bump" some of the custom colors, 
and your image will look a little different.

16-Bit Color ("High Color")
If you're using a 16-bit board (sometimes known as "high color"), you have over 32,000 colors available for
display.    16-bit images do not have palettes; therefore, only the Flat Cut option is available.    PhotoMorph 
2 supports two 16-bit formats:    Targa (TGA) and TIFF.

24-Bit Color ("True Color")
"True Color" 24-bit boards can display 16.7 million colors.    The human eye can only distinguish about 9 
million colors, so these boards essentially have all perceivable colors available for display.    PhotoMorph 2 
supports 8 True Color formats.    They are:    Targa (TGA), TIFF, Video Toaster IFF, JPEG Compressed, 
PCX, Windows DIB/BMP, Color PostScript (EPS), and Macintosh PCT.

32-Bit Color
32-bit images include an extra 8 bits of information which involves alpha channels.    Alpha channeling is a 
sophisticated image generating technique which essentially makes portions of an image "clear," so that 
another image or a background can show through.    PhotoMorph 2 supports three 32-bit formats:    BMP, 
Targa (TGA) and TIFF.

Device Dependency:    Issues and Information
Differences among devices and media become important issues to deal with when you're working with graphics.
You need to be aware of these issues if you plan to transfer images among devices that vary in their color 
support or resolution, or if you plan to print graphic images.

Clipboard Files
You may run into a problem with device dependency if you use Clipboard files (.CLP files) to transfer 
images between devices.    Some formats create device-dependent bitmaps (DDBs).    As the name implies, 
this type of bitmap includes information that is only compatible with a particular type of device.    If you are
importing a .CLP file from a different type of device, you may not be able to load it in PhotoMorph 2.

Color Support
One parameter that varies greatly among display devices is color support.    Display devices can support 
anywhere from two (monochrome) to 16.7 million (24-bit) colors.    You can imagine that transferring files 
between devices that support different numbers of colors can create problems.    As one example, if a 
picture created with a device that supports 256 colors is viewed on a 16-color video board, it will likely 
contain inaccurate colors and banding.

Differences in Resolution and Aspect Ratio
Another issue to consider is differences in resolution among devices.    An image which takes up the entire 
screen on a video monitor with a resolution of 70 dots per inch may be only three inches wide when printed on a
laser printer at 300 dots per inch.    A related issue is differences in aspect ratio (the ratio of pixel height to pixel 
width).    Pixels can appear somewhat rectangular on some devices; a square drawn on such a device may not 
look like a square, though the number of pixels on each side is actually the same.

Color Creation:    Light vs. Ink



When printing images, more problems may surface because of the different mechanisms for creating colors 
between video monitors (using light) and printing on paper (using ink).    The same image may look very 
different on a video screen than when it's printed on paper.    Video monitors use an additive method of color 
creation, using red, green, and blue light to create all of the other colors in the visible spectrum.    Printing uses a
subtractive method of color creation, with layers of cyan, magenta, yellow, and black ink mixing to create all 
other colors.    On an more elementary level, it's clear that if the red of one device looks different from the red of
another device, then all the different saturations (shades) of that color will look different as well.

Image File Compression
PhotoMorph 2 supports several different kinds of graphics file compression.    In most cases, an image's specific 
file format dictates which compression algorithm PhotoMorph 2 must use when saving the file in compressed 
form.

The one exception to this rule is the TIFF format.    You have an option to set the default compression algorithm 
that will be used when you save a TIFF file in compressed format (use the Settings dialog box under the File 
menu to change the default TIFF compression algorithm).    You may find this handy if you will be using the 
compressed images with another program that recognizes only certain types of compressed files, or if your disk 
space is of paramount concern and you need to be sure you're using the most efficient algorithm.

All standard PhotoMorph 2 image compression formats are "loss-less."    This means that no information is lost 
when the image is compressed, and therefore when it is decompressed, it will be exactly the same as before.    
However, PhotoMorph 2 can also save images in the special JPEG compression format.    JPEG is a "lossy" 
compression format.    Information can be lost when an image is compressed using JPEG.    

Aliasing & Anti-aliasing
A pervasive problem with computer graphics files is the appearance of objects that include curves or diagonals.  
The jagged appearance of such objects is caused by too-low resolution of screens or printers, which results in 
step-like approximations where there are supposed to be smooth curves or diagonals.    This phenomenon is 
known as aliasing.    Colloquially, the small step-like areas are called jaggies.

To improve the appearance of curves and diagonals, a technique has been developed which is known as anti-
aliasing.    Anti-aliasing causes the apparent smoothing of curves by capitalizing on a particular characteristic of 
the human perceptual system.    The human eye tends to blend colors that are in close spatial proximity, 
especially if the colors are also close to each other on the visible spectrum.    This causes a slight blurring of the 
edges between the two colors, resulting in the appearance of a smooth, continuous blend.    So, if the pixels that 
are near to an object's jaggies are colored a slightly different shade of the object's color, the eye will blur the 
jaggies and you will perceive a much smoother curve.    The improvement can be quite striking, since the nearby
pixels are not actually perceived to be a different color when viewed by the human eye, but the curve seems 
magically to become much more smooth and continuous.

Compressing an image file with JPEG
JPEG is a new high-compression technique for color and grayscale images.    JPEG can be used to compress 
images from one-third to one-thirtieth of their original size.    It is especially useful for images with a lot of color
and detail.    JPEG provides good compression where non-lossy compression techniques (such as Run-Length 
Encoding) do not perform well.

This JPEG software is based in part on the work of the Independent JPEG Group.

PLEASE NOTE:    JPEG is a "lossy" compression technique.    If you are not familiar with JPEG compression, 
you are advised to read the following sections, What is lossy compression? and Using JPEG Compression 
before performing JPEG compression on any of your files.

To use JPEG compression in PhotoMorph 2:
Choose File/Open.    Load (open) the file you wish to save as JPEG-compressed.
Choose File/Save As...
Look in the file formats list (click on the down-arrow button at right for a complete listing of file formats) 



and click on the item    JPG - JPEG Compression. Press OK.

A dialog box will appear.    Use this box to set the JPEG Quality setting.

The JPEG Quality setting can be any number from 1 to 100.    (In general, the higher the quality setting 
(100 being highest quality), the lower the compression rate, and as the quality setting number is lowered, 
the compression rate will rise.    Please read the sections What is lossy compression? and Using JPEG 
Compression before performing JPEG compression on your files!)

What is lossy compression?
When an image is compressed with JPEG, it is changed slightly.    This means that when the file is 
decompressed, the image's appearance will also have changed.    This is known as "lossy" compression, 
since some information is lost in the course of the compression operation.

The amount of change, or image loss, depends on the JPEG Quality setting used when compressing the file.
If the JPEG quality setting is high (highest setting = 100), these changes will probably not be noticeable to 
the human eye.    If the quality setting is lower, these changes become more noticeable.    With a quality 
setting of 50, for example, JPEG losses would be noticeable as small dots and a slight fuzziness near edges 
within an image.    With a lower quality setting, the losses will become very noticeable and will appear as 
fuzziness and small blocks.

Using JPEG Compression
Because JPEG may change an image, you should investigate its effects before deleting the original image.   
If you require high quality (very little loss but low compression rate), you should use a quality setting of 
100.    Save the image in the JPEG format (see the section above, Compressing a file with PhotoMorph 2's 
JPEG Option, for the procedure), reload it, and examine the effects of JPEG compression.    If the losses are
too noticeable, you should not use JPEG for compression, but rather save the file in the TIFF format with 
LZW compression.    This compression technique is not lossy and therefore will not change the image.

For typical use, a JPEG quality setting of 80 will give you a good balance between high quality and high 
compression rate.    Very high compression rates can be achieved by choosing a low quality setting.

Actual compression rates will depend on the character of the image being compressed.    As an example, 
scanned photographs will typically compress to between one-third and one-fifteenth of their original size 
with a JPEG quality setting of 100.

JPEG Performance
The JPEG algorithm requires computation and will take three to four times longer than a compression 
technique like LZW.    JPEG does not require a math co-processor but may run slightly faster with one.    If 
you are working with large images and notice a lot of activity on your hard disk, this may indicate that you 
need more system RAM.

There are specialized hardware accelerators which can greatly speed up JPEG.    The PhotoMorph 2 JPEG 
option does not require any such specialized hardware but will read and write JPEG images which are 
compatible with most of these accelerators.

Macintosh QuickTime JPEG
JPEG images created on a Macintosh contain a 128-byte header.    This header cannot be read by this 
version of PhotoMorph 2.
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INTRODUCTION - Why We Wrote How the Pro's Morph

This document is the result of months of creating videos with PhotoMorph 2, discussing morphing with customers
of our company, Andover Advanced Technologies, and picking the brains of the developers of PhotoMorph 2 at 
North Coast Software (who are arguably among the leaders in developing sophisticated imaging software). We 
wrote it so that a user of PhotoMorph 2 (or of any morphing package) can learn how to create professional videos 
without spending months figuring out all the hot tips of the trade. Although there are a ton of tips about morphing 
here, this list is by no means exhaustive. In fact, we are always looking for new ideas and applications for 
PhotoMorph 2 and we welcome your suggestions for future revisions of PhotoMorph 2. Remember that in the 
world of computer video, the only limitation is in the mind of the videographer.    

This document covers image morphing and warping in great detail. Other topics include storyboarding, distortion 
and transition effects. Some of the more advanced features of PhotoMorph 2 (such as Alpha Channels, and motion
morphing) are covered in the other tutorials on this CD-ROM.

Throughout this document, we refer to the person who uses PhotoMorph 2 as the videographer and the result of 
the person's work, the video. Video can be generated from photographs, computer 3-D models, or simple doodles. 
As we use the term clips we refer to pieces of the video and images are pictures that the videographer used to 
create the morph. AVI files are video files that PhotoMorph 2 generates and .PMP files are PhotoMorph 2 
Project files that can be loaded and edited with PhotoMorph 2. The Dimensions of the .AVI file pertains to the 
size (i.e.: 100x200) of the video in pixels. On most machines, the larger the dimensions, the slower the playback. 

Although the document is broken into a number of topics, there are tips that apply to all sorts of videos scattered 
throughout. Even the novice will benefit from reading the sections geared to the more serious user, and vice versa.

For those who want even more information about morphing, including the math involved, we recommend: 
Morphing Magic by Scott Anderson (1993, Sams Publishing,    ISBN: 0-672-30320-5). Although PhotoMorph 2 is
not mentioned in the text, the ideas conveyed, coupled with the theory and history presented makes for a handy 
reference tool for those serious about (or addicted to) morphing. 



INTRODUCTION -Using How the Pro's Morph

This hyperlinked document contains links to various videos throughout. To play any video, simply press the play 
button near the picture; the videos shown will illustrate the ideas conveyed in the text. Realize that every video 
referred to in this text is contained in the \VIDEOS directory on this CD-ROM and most have their respective 
PhotoMorph 2 .PMP files in the \PROJECTS directory. The best way to learn How the Pro's Morph is to analyze 
these .PMP files within PhotoMorph 2.
 
To find references to any topic in this document, use the Search button. For example, to find any references to 
screen capture: press the Search button, type screen capture and Press OK. Use the scroll bar on the right hand 
side of this window to scroll through each topic. To advance to the previous and next topic in this document, use 
the << and >> buttons.

Finally, this document is designed so that it can be printed. Feel free to do so for your own reference, but kindly 
refrain from copying it or any part of it. And please refrain from pirating this or any software product. You can 
take it from us (as refugees from several companies whose fortunes have been adversely affected by pirating) it 
hurts real people. To print a topic in this document, choose Print from the File menu.



GENERAL MORPHING - Basic Techniques
What makes a successful Morph?

The word 'Morph' comes from 'Metamorphosis' which means to change radically. Thanks to software such as 
PhotoMorph 2 by Andover Advanced Technologies, everyday people can do the impossible and create images and
videos that could never happen in the "real" world. Some of your morphs will be almost as miraculous as a 
caterpillar changing into a butterfly. The applications of this can be for business or pleasure; the only limitation is 
that of the creativity of the videographer - the laws of physics do not apply here. 

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Unfortunately, this does not give the 
videographer free reign to instantly morph two radically different images. Sometimes the total video must be 
broken down into several clips. A discussion of this occurs later in this document. Right now we'll concern 
ourselves with basic morphing between somewhat similar images. Take a look at the video TIGER.AVI. This 
video is a simple morph between two like images. Notice how the tiger seamlessly changes into a lion. This makes
it a successful morph; it almost looks like it could really happen. The best morphs make the viewer believe that 
something impossible really happened. 
Tips for Point Placement

When creating a morph in PhotoMorph 2, the videographer places a point on the starting image. A corresponding 
point appears on the ending image. The two points are "married"; in other words, they are connected together. 
When the video is rendered, PhotoMorph 2 drags the location of the first point to the location of the married 
partner. While this dragging occurs, the starting image fades out and the ending image fades in.    

When creating a morph, the videographer must carefully select each point. In the TIGER.AVI example shown 
above, points were placed on the eye, nose, ears and back of the respective felines. Use PhotoMorph 2 to examine 
the .PMP file for this video and note that there are a number of points used, especially on the eye, nose and ears. 
With PhotoMorph 2, many points can be used, and the generation time of the video will not be significantly 
increased. 

Note also that the videographer can zoom in on the images, down to the pixel level, to aid in point placement. A 
good technique to follow is to place a few points on the video on the important features. Then, after carefully 
analyzing the results, edit the points, adding more where needed. Zoom in on the image and ensure that if you are 
placing a point along an outline, that the point is right on the edge. This will reduce fuzzy imaging during the 
video. 

Places to put points:
Along outside edges
On obvious corresponding features
Along lines that are common between the two images

Places to avoid placing points: (unless videographer is seeking unusual results)
In open areas
Within 2 pixels of the edge of the entire image
Such that the points cross each other

In general, the more points that are placed on the video, the better the results. However, be sure not to go 
'overboard' in your morph point placement.

Realize that the videographer can place a point on the starting image, and not move it on the ending image. By 
anchoring a point in place, common to the two images, there will be no dragging of those points during the video. 
This technique is super useful when morphing images that are substantially different in size or shape.

When analyzing the results of a morph, be sure to carefully scrutinize all parts of the video. What is happening in 
the background? How about along the edges? Does each frame look like it could stand on its own? If each frame 
can stand on its own, you've created a successful morph.



How to deal with unlike images

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Take a look at MONUMENT2.AVI. Almost 
every image in this video differs radically from the previous image, yet the viewer is left with a satisfying series of
morphs. Maybe the pyramids were built by the Romans! Notice that although every image is different, there is 
some commonalty between the images. For example, even though the image of the Great Wall of China differs 
significantly from the Hollywood sign, a convincing morph is produced by marrying points on the two images so 
that "Hollywood" appears like graffiti on the wall. For another example, see the HOUSES.AVI video where 
houses of all different shapes and sizes morph successfully by finding common references between the images.



GENERAL MORPHING - Advanced Tips & Tricks
Creative Point Placement

As discussed in the previous section, unlike images can be successfully morphed by finding a common bond 
between the two images. It has also been mentioned that successful morphing relies upon proper point placement. 
There are a number of creative techniques that the videographer can use so that the video looks believable.

Anchoring
{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Points can be used so that stationary areas 
appear in the morph or warp. For example, look at DUNES.AVI. Notice how the person with the camera remains 
stationary while the sand dunes move around. The deficiency in this morph is that not enough anchor points were 
used, giving the cameraman a hunched back. To create an anchor: Enter the Morph/Warp editor and place a point 
on the starting image where the feature in the image is to be anchored. Be sure not to move the point after its 
placement on either the starting or ending image. By placing a point without moving it, the point will remain 
stationary through the video sequence.

Growing
{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}There are times when pieces of an image 
simply fade into or fade out from the background. A more effective morph can be achieved by having the piece 
grow out of (or into) another part of the image. Look at the following where the thermos morphs into the Coke 
can. See how the straw disappears into the can. In this case, the videographer placed points at the top of the straw 
then placed the married pairs of those points near the top of the can. Because PhotoMorph 2 drags the points on 
the image from one to another, the whole straw gets dragged to the top of the can. 

This technique can be combined with Anchoring so that other pieces of the image do not get dragged along. In the 
Coke example, the backgrounds are very similar and no odd problems appear in the morph. If, for example, there 
was something above the straw that the videographer preferred not to be dragged, points could be anchored above 
the straw.      

Expanding / Compressing
Suppose it was desired to morph a very tall and skinny object into a tall, wide object. Rather than placing points in
the center of both objects, consider the effect of placing the points along the edges of both objects. The wide 
object would expand out from the skinny object. Of course this effect could be reversed to have larger objects 
compress into smaller objects. The following screen shot from PhotoMorph 2 shows an example of expanding. 
Because the skinny object is so thin, the points had to be placed practically on top of each other.

Transition Images

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]..dog.avi}A transition image is an image that was 
created by some means to serve as a go-between in an video. All advanced video techniques use this concept. 
Examine the AVI file GUY2DOG.AVI. Notice how the person morphs into the dog with eyeglasses then into the 



complete dog. The image of the dog wearing the eyeglasses is a transition image. Generally, transition images are 
used in conjunction with other special effects; in this example, Cutting and Pasting. Outstanding videos can be 
achieved through the combination of transition images and other techniques. Transition images can be created 
within PhotoMorph 2 through the use of the preview button. Suppose the desired video was to consist of an image
warping to a second image, then a morph from the second image to a third image. To accomplish this effect, a 
transition image is needed. First, create the warp. Second, use the preview button to preview the warp and save the
warp as a new file. Next, create a new clip in the storyboard with the transition image as the start image and the 
third image as the end image. Thus, the video is created by using the preview button and the storyboard features of
PhotoMorph 2. A complete morphing project, including detailed transition images and use of the storyboard, is 
discussed in Liquid Metal Morphing, below.

Using Screen Capture

The screen capture utility within PhotoMorph 2 allows the videographer to use any image that can be displayed on
the screen as an image suitable for morphing. Some applications of this might include morphing a screen shot 
from the word processor or spreadsheet of your choice. Maybe there's an image in an .AVI file would be perfect in
the video. The possibilities are outstanding.

Some Screen Shot Tips:

Run DOS applications in a Window if a screen shot of a DOS screen is necessary.

Note that the capture utility allows the user to capture the active window, the entire screen, or a user defined area.

When capturing a window, the whole window can be captured, or only the image within the window.

The image can be captured to the Windows Clipboard, to a PhotoMorph 2 window, or to a file. 

By selecting the appropriate options, a series of images can be captured with sequential filenames.

Use of Framing

PhotoMorph 2 has a built in feature that allows the user to place a colored frame or border around an image. The 
Frame / Caption menu item under the Image menu can not only place captions or titles on images, but will also 
allow the addition of a border from one to four sides of the object in any color or thickness.

This feature is useful when morphing an image that hugs the edge of the screen. Refer back to MONUMNT2.AVI 
in the above section on How to deal with unlike images, looking closely at the image of the second pagoda. There 
is a frame along the right hand side that is two pixels wide. A point needs to be placed on the upper right hand 
corner of the roof to produce an effective morph. Unfortunately, there is no such position on this image, and 
placing the point against the edge of the image will result in the unwanted side dragging effect, discussed later. By
creating this border on the edge, the point can be placed on the edge of the original image, and no side dragging 
will occur. This technique was also used to correct the starting and ending image in the HOUSES.AVI video 
(found below under Practical Applications).

Choosing a Compression Algorithm & File Format

The third button over from the right in the PhotoMorph 2 Project Editor opens up the Video Parameters screen. On
this screen, the compression algorithm and file format can be selected. The compression algorithms include Indeo,
Cinepak and none. Each has its own advantages and disadvantages and one is not best for all. Experiment with 
each algorithm on a given video. Remember to adjust the Quality slider in the AVI Setup (press the Setup button 
in the Video Parameters section of the Project Editor under Output).

Compressions generally blur some types of images; experiment with each to see which yields the best result on a 
particular video. If the results are unacceptable, try using no compression or the .FLC file format.



Although videos that have no compression may look better, playback will be slower as hard disk access will be 
significantly increased. See TRANSFMR.AVI (found below under Liquid Metal Morphing) for an example of a 
non-compressed .AVI file.

Also in the video Parameters screen, there is an option to change the quality settings of the rendering. Note that as 
quality is increased, rendering time is likewise increased. However, the difference in output is significant. In 
general, use low quality when beginning to render the video. Once the video is finalized and the bugs have been 
ironed out, change the setting to high. Note also that some compression algorithm's setups include quality settings 
as well; ensure that these settings are always on high. 

Choosing the dimensions

The biggest problem with existing hardware and software is the inability to play back synchronized audio and 
video at a decent rate and size. It is imperative that the videographer take into account the limitations of the 
technology. Thankfully, most multimedia applications do not require full screen video - quarter screen is more 
than adiquate. PhotoMorph 2's High Quality Scaling, and Croping features are particularly useful for reducing 
large images down to reasonable sizes. Plus, many video cards now offer AVI scaling. This allows you to keep 
your video's dimensions at a resonable size (such as 320x240) then scale them to full size upon playback.



COMMON MORPHING PROBLEMS - Removing Spider-Webs

Spider webbing is the most common problem that videographers encounter when morphing images. These webs 
show up as lines or wrinkles in the video that may flash once or many times during the video. Fortunately this 
common problem is corrected easily.

To correct Spider-Webs:
Ensure there is no point crossing
Increase the Quality setting
Increase the number of points

An example of point crossing: a point on the left side of the start image is married to a point on the right side of 
the end image and a point on the right side of the start image is married to a point on the left side of the end image.
Unless this crossing effect is desired, it should be avoided. 

Here is a trick using the PhotoMorph 2 editor to determine whether point crossing is occurring unintentionally: 
Enter the Morph/Warp editor and notice the currently selected point in red. Ensure that the points are in their 
proper respective places and then press the space bar. This will select (and make red) the next set of married 
points. Ensure that these points are properly set. Continue pressing the space bar until all points have been 
verified. 

The previous illustration, a screen shot from PhotoMorph 2, has point crossing. Recall that the currently selected 
married pair is in red, the other is in blue. See how the points cross each other; they don't match up properly. 
Ensure that this does not happen in your video by tapping the space bar and carefully inspecting each married pair.

Access the quality settings for video generation through the Video Parameters section of the Project Editor of 
PhotoMorph 2. Click on the fourth button from the left, the one with the camera with the arrows coming out of it, 
to open up this area of the Project Editor. Note that the settings buttons may also include quality parameters. 
Ensure that all are set at highest quality before rendering the final .AVI file.

Sometimes the best way to eliminate spider-webs is to add more points to the images. Ensure that enough points 
are placed in the area where the spider web occurs and along the outlines of the objects within the images. When 
all else fails, delete all the points in the area of the spider-web and replace the points, ensuring that each is placed 
carefully and accurately. Use the Preview button to preview to the frame or frames where the spider-web occurs. 
Notice the change as each point is added after the window is updated. If the spider-web goes away from the 
preview, it will disappear from the .AVI file as well.





COMMON MORPHING PROBLEMS - Ghosting

Ghosting occurs when PhotoMorph 2 does not have a piece of an image to drag into an area. It appears as if a 
section of the image has been duplicated and then fades out.    Take a look at these videos:

{ewc MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi} {ewc MVMCI2, 
ViewerMCI, [device AVIVideo][stdcontrol]..dog.avi}
Both suffer from Ghosting. Durring the second half of MONSTER.AVI , the video appears fuzzy along the edges, 
then the extra fades away. In WMN2DOG.AVI the head of the woman appears to split into two parts: one morphs 
into the head of the dog, the other fades away into the background.

To correct Ghosting:
Increase the Quality setting
Increase the number of points    
Ensure that there is something to drag over the ghosted section of the image

The first two corrective measures are discussed above in Removing Spider-Webs and no further elaboration is 
needed. These techniques would correct the ghosting that occurs in MONSTER.AVI. The third corrective 
measure, described below, would correct the ghosting occurring in WMN2DOG.AVI.

To best explain how to correct ghosting, it is important to know how the morphing algorithm basically works. 
Morphing starts as a fade between two images; in fact, if no points are placed in a Morph, the video would simply 
fade from the start image to the end image. The points placed on the starting and ending images are used as 
references during the fade. As the fade occurs, the first point on the start image is dragged to the first point on the 
end image; the second point on the start image is dragged to the second point on the end image; and so on. If there
is nothing to drag into a given area, a fade occurs.

In WMN2DOG.AVI there is nothing to drag to occupy the space where the woman's head occupies in the starting 
image. To correct this, in this case, place one or more points in the upper right hand corner of the start image. 
Marry those points to the area just to the right of the dog's ear. This gives the morphing algorithm something to 
place in the area occupied by the woman's head and the ghost image of the head will disappear.



COMMON MORPHING PROBLEMS - Side Dragging

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]..rbt.avi}Side dragging is a variation on ghosting 
where PhotoMorph 2 drags in the edges of the image during the morph. Pay attention as to what happens on the 
bottom of this video. Notice how the black comes up from the bottom. The problem is caused by placing points 
too close to the edge of the image. Best results are achieved by ensuring that points are two or more pixels away 
from the edge of the screen. Use the Zoom In/Out button in the Morph/Warp Editor to examine the location of 
each point.

Often times, the videographer will want to place points along the edges of the image. A good trick is to use the 
Frame feature of PhotoMorph 2 to add a two pixel wide edge on the side of the image where the point needs to be 
placed. Note that a border can be any color, and finding an unobtrusive border is possible for almost any given 
image. Once the border is in place, the point can be placed properly and side dragging will not occur. Other 
examples of this technique are described above in the Advanced Tips and Tricks section under Use of Framing.



SPECIAL EFFECTS - Transition Effects

PhotoMorph 2 comes equipped with a Transition Editor that can be used in various ways to enhance the video. 
PhotoMorph 2's Transition Editor can be used to constuct custom transitions, or some popular transitions can be 
chosen from a list. For now, we'll concentrate on some of the transitions in this list.

Some videos that use various Transition Effects:
{ewc MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi} {ewc MVMCI2, ViewerMCI, [device 
AVIVideo][stdcontrol]...avi}
Illustrates: Illustrates:

Fade From Black Fade To Image
Fade To Image
Hold Constant
Fade To Black

{ewc MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi} {ewc MVMCI2, ViewerMCI, [device 
AVIVideo][stdcontrol]...avi}
Illustrates: Illustrates:

Curtain Open Slide Left
Slide Down Curtain Open

Fade To Black

Each Transition Effect is detailed below:

Hold Constant -
This is used for creating pauses in the video. The duration of the pause is specified by the number of frames in the 
Project Editor.

Fade to/from Black -
Fades the starting image to or from a black screen. An end image has no effect on the transition. See 
IMAGEMOD.AVI for an example.

Curtain Close/Open -
Curtain Open splits the starting image and slides it to the sides to reveal the ending image. Curtain close does the 
inverse. Use a black image to create interesting opening or closing effects, such as in MONUMNT2.AVI (which 
appears previously in this document).

Fade to Image -
Fade to Image fades from the start to the end image. This is particularly useful when creating videos using 
variations on the same image, such as in BPP.AVI. 

Slide Down/Left/Right/Up -
These effects slide the start image away, bringing in the end image. A marquee display can be created with a line 
of text and a Slide Left transition effect. Sliding to or from a black image creates an interesting start or end clip, 
such as in the ending clip of ZOOM.AVI. Notice how the slide left is used to swim in the shark in SHARK2.AVI.



SPECIAL EFFECTS - Distortion Effects

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol][range 3000]...avi}Twenty two Distortion Effects are 
available to the PhotoMorph 2 user. These effects can be used on their own to distort images, or used to create 
transitions between two images. Really nifty results can be achieved by combining two or more Distortion Effects.
Look at this video that illustrates each of the distortion effects on a basic checkerboard grid. (Some of the 
distortions shown can only be found in VideoCraft, the Windows 95 version of PhotoMorph 2.) Each clip clearly 
illustrates one effect. Remember that every Distortion Effect can be played forwards or in reverse. These have all 
be played forwards; in reverse the image would start distorted, then animate back into the undistorted, original 
image.

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Each effect can be used to transition from 
image to image. Watch IMAGEMOD2.AVI, it starts with a reverse Wave Distortion Effect, illustrating the concept
discussed above - reverse effects. The video continues with a Spherize Distortion Effect; a normal distortion 
technique. The image that is faded to was created by using a combination of techniques; see Image Modification, 
below, to see how this image was created. The three Spherizes that follow were created by using the same image 
as the start and end image. PhotoMorph 2 spherizes the image in forward, then reverse to give the illusion of a 
bucking horse. 

The next transition in IMGEMOD2.AVI was done using the Zig Zag Distortion Effect with both a start and end 
image. These sorts of transitions are incredible to watch, yet are simple to accomplish. Tweaking of the Source, 
Merge, and Destination percentages may be required. Consider starting with initial settings of 33%, 34%, and 
33%, then adjusting each figure as needed, noting that the sum of the three values must equal 100%. The video 
closes with a normal Wave Distortion Effect.

The following videos illustrate other various Distortion possibilities. For a demonstration of the Zoom In and 
reversed Zoom Out Distortion Effects, see ZOOM.AVI in the above Transition Effects section.

{ewc MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]..wmn.avi}{ewc MVMCI2, ViewerMCI, [device 
AVIVideo][stdcontrol]...avi}
Illustrates: Illustrates:

Swirl (Reverse) Lens
Compress Width Wave

{ewc MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}
Illustrates:

Zig Zag

The Distortion Effect clip series in STILLIFE.AVI is worth noting (shown below in the Still Life section). The 
series starts with a Swirl. A transition image was created to Zoom In upon by previewing the Swirl and saving the 
image. The Zoom In gives way to another transition image; this one created by previewing a Spherized image. In 
the third clip of the series, the original image is animated by running the Spherize Distortion Effect in reverse. 
PhotoMorph 2 users may want to examine this .PMP file found in the PhotoMorph 2 Projects folder.



SPECIAL EFFECTS - Cutting & Pasting

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}The technique of Cutting & Pasting is very 
useful in creating transition images. For example, look at HORROR2.AVI. The videographer used some sort of 
image editing software to cut two faces from other files and paste them onto the woman's body. Every user of 
Microsoft Windows 95 has a copy of Paint, a simple graphics editor that allows the user to cut pieces of an image 
and paste it onto another. With some time and practice, good results can be achieved by using Paint to edit images.
Of course, this process is easier with more sophisticated software. For further information about Paint, consult 
your Microsoft Windows 95 manual. Remember that more than one copy of Paint can be run at one time; 
facilitating modification (such as cutting and pasting) from one image to the next.



SPECIAL EFFECTS - Image Modification

Image Modification is a generic grouping of some of the other techniques that videographers can use and combine
in PhotoMorph 2. Some of the ideas provided here require the use of other software, such as Paint. Other image 
editing software may have comparable features.

1. Techniques using PhotoMorph 2 alone
Warping
Warping allows the videographer to change the appearance of any given image in such a way that areas of the 
image are dragged to other areas of the image. In the Ghosting section above, the basic Morphing algorithm was 
explained. Warping is the same as morphing except no fading to another image occurs. When Warping in 
PhotoMorph 2, two copies of the image appear in the editor. Placing points on the first image causes married 
points to appear on the second. By altering the position the married points on a single image, the videographer can
create the illusion of motion or entirely new images.

Percent Morphing
By previewing the morph (or any PhotoMorph 2 operation), the videographer can create a new image. This image 
can be saved and reprocessed in PhotoMorph 2. This is useful for combining two (or more) images, then doing 
something interesting with the combined image. See IMAGEMOD.AVI (shown above in Transition Effects) and 
IMGEMOD2.AVI (shown above in Distortion Effects) for examples of image combination.

Cutting & Pasting with Percent Morphing
Of course this concept of Percent Morphing can be combined with the Cutting and Pasting Technique described 
above. In IMAGEMOD.AVI, this was done to the temple / parachute image. The grass below the temple was 
erased using Paint, then this edited image was combined using a Percent Morph preview with the parachute. The 
same was done with the background behind the horse in IMGEMOD2.AVI, but the space was filled with purple, 
rather than left white. These are just two examples of results possible by combing various techniques. Recall that 
morphing itself is the combination of warping and cross-fading. There are many new and useful combinations 
waiting to be discovered. 

Image Menu Options
The image menu of PhotoMorph 2 gives the videographer additional image modification tools. Invert Image 
produces a "negative" of the original image. Flip Image turns the image upside down whereas Mirror Image turns 
the image from Left to Right. Crop and Scale allow the images to be re-sized in various ways. Rotate turns the 
image by degrees. The usefulness of Frame / Caption where borders and text can be added to the image was 
described in the Advanced Tips & Tricks section under Use of Framing. The Tile feature takes the image and 
multiplies it upon itself, as in SHARK2.AVI where Tiling was combined with Scaling. Finally, the Mask tool 
allows the videographer to place one of 17 masks on top of the image, so that the image shows through (or 
around) the mask. 

Contrast / Brightness and Hue / Saturation controls allow the videographer to change the coloring of the image. 
Both IMAGEMOD.AVI and IMGEMOD2.AVI include images where the coloring has been altered with these 
filters. A neat effect, used in IMAGEMOD.AVI is to adjust the coloring of an Inverted image, then do a Percent 
Morph of this image with another. This was done to create the "plankton under the sea" image in 
IMAGEMOD.AVI. The two images used are the flowers and the beach. The beach was inverted, then the flowers 
were Percent Morphed on top of the inverted sea. The resulting image was color corrected using the Contrast / 
Brightness and Hue / Saturation controls of PhotoMorph 2. 

Filter Menu Options
This menu contains the following filters: Sharpen, Sharpen Edges, Despeckle, Emboss, Blur, Median, Trace 
Edges, Noise, Maximum, and Minimum.      See the section on Liquid Metal Morphing for an example of a 
technique combing the Emboss filter with Cutting & Pasting.

2. Techniques using PhotoMorph 2 with Paint
Cutting & Pasting 



The technique of Cutting & Pasting using Paint is discussed in two other sections of this document: Cutting & 
Pasting, above, and below in Liquid Metal Morphing. Both sections are worth reviewing.

Filling / Erasing areas
This technique was touched upon in the above section of Cutting & Pasting with Percent Morphing. Recall that 
Paint allows the user to draw upon or erase any part of an image. The videographer can erase sections of an 
image, or fill areas in with a few clicks of the mouse. Another application of this idea is discussed in the Liquid 
Metal Morphing section, below.



SPECIAL EFFECTS - Still Life

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Through the combination of PhotoMorph 2's 
Warping capabilities, its effects, and the use of techniques discussed above, an videographer can bring life to a still
image. Watch this video; concentrate first on the second half of the video where the mouth of the stone statue 
closes. Note that the anchoring technique, the concept of transition images, the use of the Hold Constant 
Transition Filter and the Warping capabilities of PhotoMorph 2 are all combined in this section of the video. 

To accomplish the Warp on the statue in STILLIFE.AVI, points were placed around the edges of the statue's open 
mouth; the married points were placed in the middle of the mouth. When PhotoMorph 2 generated the video, the 
top and bottom of the mouth were dragged towards each other, yielding the mouth-closing effect. The 'breathing' 
effect of the statue, as well as the effects on the lobster were generated in exactly the same way. In general: place 
points along the edge of the section of the image where the motion is to occur, place the married points in the 
section of the image where the motion is to end, and place anchor points as needed.

Note that sometimes it is better to morph, rather than warp, from a warped image back to the original. This was 
done on the lobster, where the claw changes back to the original shape and on the statue, when it breathes. No 
matter which technique is used, careful point placement is crucial to create the illusion of motion with still images.

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Another technique to still life is to use the 
Spherize Distortion Effect. Moderate use of this effect on some images can yield good results. Besides having an 
outstanding series of warps on the end of this video, the videographer used Spherize to intensify the close up of 
the lizard's eye. Another video on this CD-ROM that uses the Warping techniques described above is 
DUNES.AVI.



SPECIAL EFFECTS - Warp / Fade Combinations

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}An interesting trick is to combine Warping and 
Fading. Look for this technique during the following MOUNT.AVI. Notice the clip where the mountain Warps 
into a completely different shape, then fades into the next mountain. This was done by warping the outline of the 
first mountain onto the outline of the second. In PhotoMorph 2, it is possible to chose an 'end image' for warping. 
The end image is not shown in the video, but can be used by the videographer as a reference for point placement.

In this case, the second mountain was used as a guide for point placement. Preview was used to generate the 
transition image, and in the next clip, the warped, transition image fades to the second mountain, creating a two 
step morph.



SPECIAL EFFECTS - Liquid Metal Morphing

Creating a liquid metal morph using PhotoMorph 2 is a multi-step process that requires time and patience to 
generate astounding videos. As with any large video, the project must be subdivided into smaller transitions. It is 
necessary to think of the entire video in this manner as there is no "Liquid Metal Morph" filter in PhotoMorph 2. 
A typical subdivision process consists of determining the start and end images, visualizing the images needed for 
the morph to take place, generating those intermediate images and determining any resting points or pauses in the 
video.

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}The first step of this process, determining the start
and end images, is fairly straightforward. The videographer must consider whether the entire object of the morph 
will turn to liquid metal, or a only a portion. In the example, LQMETAL.AVI, only the skin turns to metal, the hair 
and clothing are subject to a normal morph.

Next, the videographer must determine the intermediate images needed to create a convincing morph. Generally, 
the following images will be needed: a liquid metal version of the original image, a transition liquid metal image, 
and a liquid metal version of the final image. This is the case with the example video; there are three intermediate 
images: a liquid metal version of the little girl, a transition image that consists of portions of both images, and a 
liquid metal version of the older woman.

The intermediate images can be created in a number of ways. Owners of sophisticated image editing software may
find this to be a trivial task, but the rest of us have limited options. Luckily, Windows 3.1 comes with the Paint 
accessory, a simple graphics editor that can be used to modify images. A simplistic approach to generating the 
liquid metal version of the start and end image would involve loading the image into Paint, tracing the important 
features in dark gray, and filling the other sections of the image in varying shades of gray. However, the results 
from this exercise may be less than convincing.

An alternate method for creating a liquid metal image would require taking the original image into PhotoMorph 2,
changing the image colors to grayscale, and cutting and pasting the metal portion of the image on top of the 
original background. See the above section on Cutting & Pasting for some tips. Combine this with the Percent 
Morph and Contrast / Brightness & Hue / Saturation    techniques described under Image Modification, and better 
results are available.

Those facile with PhotoMorph 2's Alpha Channels, can recreate these images by creating an alpha channel on the 
areas that need to be embossed. Then, the image can be put through PhotoMorph 2's Colorize Effect and 
Embossed and Morphed similtanously. Consult the section on Alpha Channels in the PhotoMorph 2 manual for 
more details.

In the example, the liquid metal images were created using the Emboss effect found in the Filter menu. After 
Embossing a grayscale version of the original image, the cut and paste feature of Paint was used to create the 
liquid metal version of the start and end images. 

If the videographer has access to sophisticated rendering or 3-D Modeling software, such as Arena Design by 
Andover Advanced Technologies, excellent results are possible. The following video was generated combining 
such software with PhotoMorph 2, and the results are very professional. 

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Once the liquid metal versions are created, a 
composite image can be created, if desired. In the example, the older woman's metalized face was pasted on top of
the girl's metalized body. The resulting image has an eerie sci-fi look to it that is sufficient for this video. 
Alternatively, a composite image could be generated by morphing the two metalized images together, previewing 
the morph, and copying a 50% morph to another window or file. This technique of previewing a partial morph can
also be used in conjunction with a Paint edited image to create the liquid metal version of an image. Reveiw the 
section on Image Modification for more ideas on generating metalized and composite images.

All metalized images can be improved upon in various ways. Paint is handy for editing on the pixel level to fix 



any rough spots created during the cut and paste. Experiment with the Contrast / Brightness and Hue / Saturation 
controls to change the color tinting within the image. In the example, the yellow contrast and brightness were 
increased to give each metalized image a more metallic look. To offset the resulting glossy background, the blue 
contrast and brightness were increased as well. Caution should be used when changing color contrasts and hues 
because it is very easy to overdo the effect. Ensure that the images have been saved before tweaking them.

In the final step of the preparatory process, the videographer determines the points in the video where pauses 
should occur. A slight pause gives the viewer the opportunity to focus on the transition. In the example, a pause 
was inserted after the original image changes to its metalized form, and after the transition image changes to the 
metalized form of the final image.

Once the original image, the metalized version of the original image, the transition image(s), the metalized version
of the final image, and the final image have been created and loaded back into PhotoMorph 2, the actual video 
process can begin. A PhotoMorph 2 video can consist of one or more clips combined on the PhotoMorph 2 
Storyboard. The Storyboard button is located on the top of the Project Editor Window, the 5th button from the left 
which has two arrows converging onto a filmstrip. (See the Project Editor section of PhotoMorph 2 manual for 
more information about the Storyboard.)

The complete video can be laid out in the Storyboard. The example, LQMETAL.AVI, was done in the following 
manner:

Clip 1: The starting image fading to the metalized starting image.
Clip 2: A pause on the metalized starting image.
Clip 3: A morph from the metalized starting image to the transition image.
Clip 4: A morph from the transition image to the metalized final image.
Clip 5: A pause on the metalized final image.
Clip 6: The metalized final image fading to the final image.

The videographer can create the complete video using the same basic outline. The fade to images (Clips 1 & 6) are
created using the Transition filter set to the Fade to Image option. Because the images have the same outline, only 
the colors change, the Fade to Image Transition saves video and computation time. Pauses (Clips 2&5) are created
by using the Hold Constant Transition with no ending image. Finally, the morphs (Clips 3&4) are set up; starting 
with just the basic points as more detail will be added later.

When using the Storyboard, the videographer should realize the importance of the New Clip button (located 
between the Start and End image windows, with the single arrow pointing to a filmstrip). Once the first clip (in 
our example, Fading from the girl to the metalized version of the girl) has been created, clicking on the New Clip 
button creates a new clip where the metalized version of the original image is automatically inserted as the start 
image of the new clip. Clicking on the Storyboard button (described above) will show all clips, with the clip that 
is currently loaded in the Project Editor outlined in red and the selected clip outlined in blue. Double Clicking on 
any clip selects it and loads it into the the project editor. Note also that the new clip button preserves morph/warp 
points. This is useful when morphing from image A to B then from B to C, as done in the example with clips 3 and
4. The points set in the first clip on image B will be preserved when creating a new clip so that only the points on 
image C will need to be adjusted. 

The complete video can now be produced. To save time during the first renderings, keep the quality setting on the 
video set to low. When the video needs only final tweaking, change the quality setting(s) to high. To change the 
quality of the video, click on the Animate Parameters button, the third button from the left. Click on the 
Compression and Output setup buttons to ensure each is set to the highest quality level, and change the overall 
video quality to high. Trips to the coffee machine will be in order while rendering an video with these settings, but
the improvement in the final .AVI (or .FLC) file will be quite noticeable. See the above Advanced Tips & Tricks 
section for further discussion of these issues.

Once the basic video has been rendered, it will be apparent where improvements will be necessary. Analyze each 
image for any flesh that may be showing through the metal. The Median filter, included in the PhotoMorph 2 
patch will help correct some rough edges created while cutting and pasting. Trips back to the Paint editor and 
more experimenting with the color contrasts and hues may also be in order. Always be sure to have a backup copy 



of your images, just in case.

Each morph can be tweaked to perfection. Using the Preview Window (the seventh from the left, with the 
magnifying glass on it), the videographer can set the morph on any rough spot during the video, add points using 
the Morph/Warp editor, and then use the update button in the Preview Window to see the changes. This saves the 
time of having to render an video repeatedly while trying to smooth out a rough spot in the morph. Solutions to 
common morphing problems such as ghosting, spider webs, and side dragging are discussed above. However, it 
should be repeated that adding points to a morph or warp does not significantly change the computation time 
required to render the video.

The last step for the videographer to consider is the timing of each clip in the video. PhotoMorph 2 allows the user
to specify the number of frames each clip should occupy. Note that the number of frames for the currently loaded 
clip are specified in the Project Editor Window, under the ending image. For example, if the pauses in the video 
are too long, decrease the number of frames that the pause occupies. For more dramatic results, the speed of a 
morph can be decreased by increasing the number of frames that the morph occupies. 

Although using PhotoMorph 2 alone may not yield Terminator 2 quality liquid metal transformations, the package
is flexible enough to produce startlingly good results. Using specialized photo-editing or 3-D modeling software, 
the metal versions of the start and end images would appear more realistic, dramatically improving the quality of 
the video. As with any video project, the better the source material, the better the final product.



PRATICAL APPLICATIONS - Corporate Use

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}PhotoMorph 2, combined with other 
multimedia software packages, can be used to enhance business presentaions, demonstrations, and interactive 
kiosks. Why not morph a series of products, such as in HOUSES.AVI. Of course this concept can be taken to any 
industry. Eye-catching animated logos can be created. Skin care professionals can morph before and after shots of 
clients to show aging. Animal lovers can cross-breed various animals. Entirely new automobiles can be designed 
(Cross a Volvo with a VW?). A graphic artist can use morphing in pre-press graphic design for advertising, fine 
art, etc. Professional photographers can tweek their photographs - or distort them. Artists can use morphing and 
warping for caricatures and cartoons. With all the interactive CD-ROM games coming out, surely one can feature 
morphed videos. Even that custom tee-shirt maker in the mall can use PhotoMorph 2 to graphically distort people 
for their tee-shirts. The possiblities are endless. 



PRATICAL APPLICATIONS - Educational Use

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}Morphing can be used to illustrate various 
scientific theories. Morph a monkey into a man to show the Theory of Evolution. Human development, weather 
patterns and continental drift can all be animated through morphing. As software such as PhotoMorph 2 becomes 
available to anyone, educators can use video to liven up classroom demonstrations.



PRATICAL APPLICATIONS - Video Production

{ewr MVMCI2, ViewerMCI, [device AVIVideo][stdcontrol]...avi}As a special effect, morphing is hard to beat. 
Take a look at SMOKING.AVI. When combined with video editing software, PhotoMorph 2 can be used to create 
special effects for feature film and television production projects. Eye catching ads are easily created with 
PhotoMorph 2. In a digital video editing suite, PhotoMorph 2 becomes an invaluable special effects device.



PRATICAL APPLICATIONS - Personal Use

It appears that many people enjoy morphing people into their pets. Of course, the whole family can be brought in on 
the fun to illustrate family heritage and resemblances, bringing boring slide shows to life. Remember that morphing 
is only one tool in the creative toolbox, the limits of its use is determined solely by the videographer.




